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1 Achtergrond

1.1 Het ontstaan van KOSWAT

KOSWAT (KOSten voor versterken WATerkeringen) is een instrument waarmee kosten van
dijkversterking kunnen worden geraamd. De basis voor het huidige KOSWAT is door Deltares
gelegd binnen het programma ’Waterveiligheid 21e eeuw’ (WV21) in de periode 2009-2010,
met de ontwikeling van een tool op basis van Excelsheets en Matlabscripts.

Door het Expertise Centrum Kosten (ECK) van het Deltaprogramma is eind 2011 opdracht ge-
geven aan Deltares om het KOSWAT instrument te professionaliseren. Dit om het instrument
KOSWAT voor de diverse Deltadeelprogramma’s (DP Veiligheid, Rijnmond-Drechtsteden, Zuid-
westelijke Delta, Rivieren, IJsselmeergebied, Wadden en Kust) te kunnen inzetten. Dit heeft
in 2012 geresulteerd in de oplevering van KOSWAT versie 1.1.

Eind 2012 is door het Deltaprogramma Rivieren aangegeven dat er behoefte was aan aanvul-
lende functionaliteit. Tevens is in 2013 vanuit RWS DGRW een aanvullende opdracht gegeven
om KOSWAT verder te ontwikkelen ten behoeve van het nieuwe Hoogwaterbeschermingspro-
gramma (nHWBP). Dit heeft in juni 2013 geresulteerd in de oplevering van KOSWAT versie
2.1. In 2014 is Koswat verder ontwikkeld in opdracht van het Hoogwaterbeschermingspro-
gramma en Directoraat Generaal Ruimte en Water (DGRW). Vanaf 2015 wordt KOSWAT door
Deltares beheerd en onderhouden in opdracht van Rijkswaterstaat.

1.2 Wat is KOSWAT?

Zoals reeds vermeld is KOSWAT een instrument waarmee kosten van dijkversterking kun-
nen worden geraamd. KOSWAT kan gebruikt worden om over programma’s en projecten
heen een zelfde kostenbasis te geven aan alle geraamde maatregelen en oplossingen, om
zodoende ook kosten met elkaar te kunnen vergelijken. Een berekening in KOSWAT kan
gemaakt worden met een aantal standaardaannamen ten aanzien van het ontwerp, maar
KOSWAT is flexibel om vervolgens ook een aantal mogelijke variaties door te rekenen om
gevoel te krijgen voor de bandbreedte rond een raming.

Figuur 1.1: Het concept van KOSWAT
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KOSWAT heeft informatie nodig met betrekking tot dijksecties en hun eigenschappen, de toe-
komstige hydraulische belasting, de vereiste dimensies van de dijkversterking, en een aantal
omgevingsfactoren rond de dijk. De toepasbaarheid van een versterkingsmaatregel heeft te
maken met de aanwezigheid van bebouwing, (spoor)wegen en grote waterlichamen. Aan
KOSWAT ligt een ruimtelijke analyse ten grondslag, waardoor de ligging van deze objecten
bekend is. Als er weinig ruimte beschikbaar is, moet er een meer technische dijkversterking
worden gekozen. Uitgangspunt in KOSWAT is dat bebouwing niet wordt gesloopt, in prak-
tijk zal hier altijd een afweging gemaakt worden, waarbij overigens niet alleen kosten een rol
spelen.

Veelal de goedkoopste en tevens de meest duurzame oplossing is dat een dijk volledig in
grond wordt versterkt. Wanneer piping op een dijksectie aan de orde is, maar er geen ruimte
is voor de aanleg van een (lange) pipingberm stapt KOSWAT over op een maatregel met
een licht kwelscherm in de teen van de dijk. Wanneer tevens geen ruimte aanwezig om een
stabiliteitsmaatregel in grond te plegen, wordt een stabiliteitswand (damwand of diepwand)
aangebracht tot in de kruin van het dijklichaam. Wanneer de dijk volledig ingeklemd ligt tussen
bebouwing, en de dijk feitelijk alleen recht omhoog kan, wordt gekozen voor een kistdam.
Op een dijksectie wordt zodoende een mix van maatregelen ontworpen, afhankelijk van de
omgeving. Zie hiervoor figuur 1.2.

Figuur 1.2: Rekenresultaten dijksectie per scenario op de kaart

KOSWAT heeft nog drie andere mogelijke oplossingen tot z’n beschikking, het betreft hier
drie, in complexiteit toenemende maatregelen die worden toegepast op plaatsen met een
constructieve uitgangssituatie. Omdat KOSWAT op deze plaatsen feitelijk geen dijkontwerp
kan maken, worden de kosten hiervan door middel van een factor gekoppeld aan de kosten
van een kistdam.

KOSWAT maakt met behulp van de SSK systematiek (de Standaard Systematiek voor Kos-
tenramingen in de GWW sector) een raming van de totale investeringskosten gemaakt door bij
een bepaald dijkontwerp hoeveelheden te vermenigvuldigen met eenheidsprijzen en opslag-
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factoren. In de berekening worden ook kosten van aanpassing (vervanging) van infrastructuur,
kunstwerken en dijkbekleding meegenomen.
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2 Beschrijving user interface

Dit hoofdstuk is bedoeld om de gebruiker bekend te maken met de algemene functionaliteit
van de KOSWAT user interface, en de plaats waar informatie gevonden kan worden in de
applicatie.

2.1 Hoofdscherm

2.1.1 Overzicht

Wanneer KOSWAT wordt opgestart verschijnt het hoofdscherm. Het hoofdscherm omvat vier
deelvensters (figuur 2.1). De inhoud van deze deelvensters is verdeeld over verschillende
tabs. De inhoud van deze tabs zal per deelvenster worden besproken in de volgende para-
grafen.

Figuur 2.1: Beginscherm na opstarten KOSWAT

Bij het openen van de applicatie wordt automatisch een default templatebestand op de ach-
tergrond geopend, dat met de applicatie is meegeleverd. Deze template is de basis voor een
nieuw KOSWAT project. In de template zijn naast de default rekeninstellingen tevens de een-
heidsprijzen en opslagfactoren vastgelegd. Het prijspeil van de meegeïnstalleerde template
is 1 januari 2013. KOSWAT maakt gebruik van het prijzenboek opgesteld door het Expertise
Centrum Kosten en Baten (ECK-B) van het Deltaprogramma, dat valt onder Rijkswaterstaat
Dienst Infrastructuur. In de template zitten verder de achtergrondkaart en de ligging van de
dijkringlijnen (volgens het RWS basisbestand dijkringlijnen versie 4.0).

Het templatebestand wordt meegeïnstalleerd op lokatie:
c:\programdata\Deltares\Koswat\KOSWAT_template_v2.3_pp2013.kwx.

De omgevingsdatabases waar KOSWAT gebruik van maakt in z’n analyses zitten niet in de
template, maar zijn apart geinstalleerd in bovenstaande map (*.olp files).
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2.1.2 Werkbalk en menu’s

In de bovenbalk van KOSWAT bevindt zich een aantal menu’s en iconen. Hieronder (fi-
guur 2.2) is kort aangegeven welke functionaliteiten waar te vinden zijn in KOSWAT.

Figuur 2.2: Menu’s en werkbalk

Via het menu kan veel informatie worden opgeroepen. Onderstaande tabel beschrijft de in-
houd van de verschillende schermen. Dit is slechts een opsomming; verdere verduidelijking
volgt in de latere hoofdstukken.

Bestand Nieuw: starten van een nieuw project op basis van de default template
(paragraaf 3.1)

Open: bestaand project openen (paragraaf 3.2)

Opslaan: opslaan van project onder huidige naam

Opslaan als: opslaan van project onder nieuwe naam

Importeer: importeren van gegevens m.b.t. dijkvakligging, dijk-
vakinformatie en scenario’s (paragraaf 3.1.2)
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Bestand
(vervolg)

Export: exporteren resultaten:
� Resultaten CSV: de resultaten in een tekstformaat, dat ingelezen

kan worden bijvoorbeeld in MS Excel, zodat de resultaten ook
buiten KOSWAT te lezen zijn

� Resultaten shape: .shp-bestanden waarmee de resultaten in een
GIS-omgeving bekeken kunnen worden: kosten per km en per
segment

� Ruimtebeslag shape: .shp-bestand waarmee de resultaten in
een GIS-omgeving bekeken kunnen worden: wat is het ruimte-
beslag van de berekende oplossing?

Recente projecten: hier staat een lijst met recent geopende project-
bestanden

Afsluiten: afsluiten van KOSWAT

Bewerken Ongedaan maken: ongedaan maken laatste actie

Opnieuw: ongedaan gemaakte actie opnieuw toepassen

Verwijderen: verwijderen van geselecteerde item

Beeld Herstel: zet de vensterindeling van KOSWAT weer terug naar beginin-
stellingen

Kaart: maakt venster met kaart van Nederland actief, of opent
hem, indien gesloten (paragraaf 2.2)

Dwarsdoorsnede: maakt venster met doorsnede van dijkprofiel
actief, of opent hem, indien gesloten (paragraaf 2.3)

Eigenschappen: maakt eigenschappen venster actief, of opent
hem, indien gesloten (paragraaf 2.4)

Meldingen: maakt venster met foutmeldingen actief, of opent
hem, indien gesloten (paragraaf 2.6)

Uitvoer: maakt venster met uitvoer van importers actief, of opent
hem, indien gesloten (paragraaf 2.7)

Tabellen: maakt venster tabellen actief, of opent hem, indien ge-
sloten (paragraaf 2.5)
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Project Project: Opent venster met daarin gegevens over:
� Project (=kosten per scenario, pas zichtbaar nadat een bereke-

ning heeft plaatsgevonden) (paragraaf 2.4.1)
� Constructietypen: kosten benodigd voor aanpassing aan een

van de verschillende typen constructies (paragraaf 2.4.2)
NB: om de gegevens op te roepen, moet het ’Eigenschappen’-venster
open zijn. Deze is te openen via Beeld > Eigenschappen.

Systeemaannamen: Opent een venster waarin rekeninstellingen
gemaakt kunnen worden die geldig zijn voor het gehele project (zie
paragraaf 3.5).

Eenheidsprijzen: Opent een venster waarin de eenheidsprijzen
aangepast kunnen worden (zie paragraaf 3.4).

Berekening Schrijf DAM files: wanneer in een project dijkvakken zijn gedefini-
eerd waarvan de versterking met DAM berekend moet worden (zie
paragraaf 3.6.4), kunnen met deze menuoptie de DAM invoerfiles
gegenereerd worden (formaat: .damx).

Lees resultaten uit DAM files: Na het berekenen van de DAM
dijkvakken, dienen de resultaten weer geïmporteerd te worden in
KOSWAT. Met deze menuoptie kan aangegeven worden waar de DAM
rekenresultaten te vinden zijn (formaat: .damx).

Start: hiermee kunnen de kosten berekend worden nadat alle
rekenopties zijn gekozen. Ook uit te voeren middels een button in het
beginscherm (zie ook paragraaf 4.1). Wanneer deze menuoptie niet
beschikbaar is, zijn er waarschijnlijk nog foutmeldingen te vinden in
het meldingenscherm (paragraaf 2.6)

Stop: stopzetten van de berekening

Gereedschap Opties: programmakeuzes:
� bij opstarten KOSWAT starten met nieuw of laatst geopend pro-

ject
� kiezen voor een taal (Nederlands/Engels)

Eenheden: Bepalen in welke eenheden de verschillende eenheden
worden uitgedrukt, zoals:

� getallen
� doorsnedes
� gewicht en druk
� hoeveelheden/prijzen
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Help Info: opent venster met informatie over de huidige KOSWAT versie.
Versienummer, releasenotes, known bugs, e.d.

Handleiding: opent de KOSWAT handleiding (*.pdf) in een ex-
terne pdf viewer.

www.helpdeskwater.nl: support voor KOSWAT wordt verkre-
gen via www.helpdeskwater.nl. Vul hiervoor het meldingsformulier
in, te vinden met de zoekterm KOSWAT.

Vanaf paragraaf 2.2 wordt de inhoud van de verschillende tabs beschreven. Het vormt een
verdere verduidelijking van bovenstaand schema.

2.1.3 Indeling van vensters

De user interface van KOSWAT is zeer flexibel ten aanzien van het maken van een scherm-
indeling die de gebruiker zelf het prettigst vindt werken. Vensters kunnen ten opzichte van
elkaar verplaatst worden door op de bovenbalk van het venster te klikken, en het venster te
verslepen terwijl de linker muisknop vastgehouden wordt. Hiermee kan een venster als het
ware losgetrokken worden, en ’floating’ boven een ander venster worden geplaatst. Zie als
voorbeeld het dwarsdoorsnede scherm in figuur 2.3 dat als het ware boven de applicatie ligt.
Het venster kan hiermee ook verplaatst worden naar een secunair scherm. Door met de muis
boven de rand van een floating venster te gaan staan kan het venster worden vergroot of
verkleind.

Om het scherm op een bepaalde plek vast te klikken aan de applicatie kan het venster we-
derom vastgepakt worden met de linker muisknop en over de user interface worden bewogen.
Op het scherm verschijnen dan icoontjes waar het scherm kan worden ’gedockt’. Als je (met
de linker muisknop nog steeds ingedrukt) het venster naar één van deze icoontjes sleept zie
je waar het venster bij loslaten van de muisknop terecht komt. Het venster kan ook als tabblad
in het venster bij een ander venster geplaatst worden, door het venster te verslepen naar het
middelste icoontje in bijvoorbeeld het kaart scherm figuur 2.3.
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Figuur 2.3: Verplaatsen van vensters

Vensters die in de applicatie vastgeklikt zijn kunnen geschaald worden door de rand van het
betreffende venster te verslepen, zie figuur 2.4.

Figuur 2.4: Schalen van vensters

Als laatste kunnen vensters gesloten worden als de gebruiker ze niet wenst te gebruiken,
of geminimaliseerd worden weergegeven als tab aan de rand van het scherm (figuur 2.5).
Wanneer de gebruiker met de muis op de tab van het verborgen venster gaat staan, komt het
venster weer tevoorschijn. Gesloten vensters kunnen te allen tijde weer opgeroepen worden
in het menu Beeld.
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Figuur 2.5: Vensters minimaliseren en sluiten

2.2 Kaart

In het venster ’Kaart’ wordt bij het opstarten van de applicatie een achtergrondkaart van Ne-
derland getoond, met in lichtgrijs de dijkringlijnen waar KOSWAT in principe een berekening
kán maken. Op deze plaatsen is informatie beschikbaar over de omgeving (bebouwing, infra-
structuur, e.d.). In principe zijn dit alle keringen van de categorie a en c en van het type ’dijk’
in het RWS Basisbestand Dijkringlijnen versie 4.0.

Figuur 2.6: Kaartvenster overzicht

Wanneer een gebruiker werkt aan een project is in het venster informatie te zien over de
aanwezige dijksectie indeling, en worden hier berekeningsresultaten getoond (zie figuur 2.6).
Hier wordt verder op ingegaan in paragraaf 4.2.
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Figuur 2.7: Menubalk in kaartvenster

Bovenin het kaartscherm bevindt zich een menubalk, met de volgende functies, zie figuur 2.7:

� Wissel selectie: met deze functie ingeschakeld (na het indrukken van de button blijft de
knop zichtbaar actief) kun je dijkvakken selecteren of deselecteren om mee te nemen
in de berekening, zie ook paragraaf 3.3.

� Zoom naar alle kaartlagen: alle kaarten die in de viewer te zien zijn (m.u.v. de we-
blayer), worden volledig zichtbaar. Er wordt dus uitgezoomd.

� Zoom naar gegevens: zoom dusdanig dat gegevens die in een project zitten op kaart
passen.

� Zoom per rechthoek: Bij het tekenen van een rechthoek van linksboven naar rechts-
onder, wordt op dit deel ingezoomd. Bij het tekenen van een rechthoek van rechtsonder
naar linksboven wordt uitgezoomd (het zichtbare deel van het scherm wordt verkleind
naar de getekende rechthoek).

� Zoom tot geselecteerde data: als er een dijksectie is geselecteerd, kan met deze
knop worden ingezoomd naar de geselecteerde sectie

� Toon legenda: laat zien wat de figuren en kleuren in de kaart betekenen, zoals kosten
per km, of landgebruik van een bepaalde maatregel, zie figuur 2.13. Vanuit de legenda
kan ook opmaak van diverse lagen worden aangepast, of de volgorde van lagen worden
gewijzigd.

� Openen laag van bestand: hiermee kan een externe shapefile onder de resultaten
worden gelegd om de resultaten te interpreteren met lokaal beschikbare kennis. Ge-
dacht kan worden aan bestanden uit de legger, die vaak een bekende referentie vormen
voor de beheerder, of bestanden waar ondergrondse infrastructuur in staat die maat-
regelen kan bemoeilijken. Aan KOSWAT ligt een ruimtelijke analyse ten grondslag van
(water)wegen, spoorlijnen en bebouwing. De .shp-bestanden die voor deze analyse zijn
gebruikt kunnen in de viewer worden geladen om te kijken waarom KOSWAT overgaat
tot een bepaalde oplossing (zie bijvoorbeeld figuur 4.3).

� Exporteer kaartlagen: exporteer kaartlagen in de viewer als shapefile voor gebruik in
een externe applicatie.

� Opslaan kaart als afbeelding: maakt een plaatje van het beeld in de kaartviewer.
� Selecteer achtergrondkaart: selecteer de achtergrondkaart die weergegeven wordt in

de kaartviewer. Gekozen kan worden uit:
1 Open Street Map: toont de topografische kaart van Open Street Map. Hiervoor
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is een internetverbinding noodzakelijk.
2 Basiskaart (PDOK): toont de topografische kaart van PDOK. PDOK staat voor

Publieke Dienstverlening op de Kaart, een service van de Nederlandse overheid,
waarmee de overheid innovatie en gebruik van geo-informatie wil stimuleren. Zie
voor meer info http://www.pdok.nl. Voor het activeren van deze laag is een
internetverbinding noodzakelijk. Voor een voorbeeld van deze laag zie figuur 2.8.

3 Luchtfoto PDOK: luchtfoto’s als achtergrondkaart. Hiervoor is een internetver-
binding nodig.

4 Koswat kaart: dit is de eenvoudige basiskaart die meegeleverd wordt met KOS-
WAT voor offline gebruik.

Figuur 2.8: Basiskaart PDOK als achtergrondkaart

In het kaartvenster wordt informatie getoond over het actieve KOSWAT project. Dit wordt later
in de handleiding beschreven.

2.3 Dwarsdoorsnede

In het tweede venster wordt de dwarsdoorsnede van de actieve dijksectie grafisch weerge-
geven (figuur 2.9). In donkergroen het profiel van de dijk in de uitgangssituatie, na rekenen
in lichtgroen het profiel van de versterkingsmaatregel. In donkerblauw is aangegeven welke
maatgevende waterstand wordt gehanteerd in de referentiesituatie, en het daarbij behorende
hydraulisch belastingniveau (HBN, incl. golfoploop). In lichtblauw de ontwerpbelasting in het
gekozen scenario.
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De standaarddoorsnede laat zo duidelijk mogelijk de hoogteverschillen zien, waarbij de hoogte
en de breedte van de dijk onafhankelijk van elkaar worden geschaald zodanig dat ze in het
venster passen. Het klikken op de loep met ‘=’-teken laat zien hoe de dijk eruit ziet in realis-
tische verhoudingen, schaal in L- en Z-richting gekoppeld. Met de knoppen in de werkbalk in
dit venster kan de hoogte worden afgelezen (pijl), geschoven worden in het beeld (hand), te-
rugzetten naar standaarddoorsnede (loep met rechthoek), loep met realistische verhoudingen
(loep met =), vrijuit inzoomen (loep met gestippelde rechthoek).

Figuur 2.9: Dwarsdoorsnedescherm

2.4 Eigenschappen

In het eigenschappenscherm wordt informatie getoond, die afhankelijk is van de handeling
waarmee de gebruiker op dat moment bezig is. In de volgende paragrafen worden de belang-
rijkste functies van dit venster beschreven.

2.4.1 Project

Dit venster is op te roepen via de menuoptie Project>Project, en geeft de totale investe-
ringskosten weer per doorgerekend scenario voor het gehele project (dus een totaal over
de berekende dijksecties) in een tabel en in grafiekvorm. Verschillende scenario’s kunnen
bijvoorbeeld worden gekenmerkt door verschillende maatgevende waterstanden voor de toe-
komstige situatie. Bovenin wordt weergegeven met welk prijspeil wordt gerekend, en of de
berekening in- of exclusief BTW is (dit kan worden ingesteld in het venster Eenheidsprijzen,
paragraaf 3.4.3). Na een berekening verschijnen in de grijze velden per scenario de totale
investeringskosten voor ieder scenario. Wanneer dijkvakken aan of uitgevinkt worden zodat
ze al dan niet in de berekening worden meegenomen (zie paragraaf 3.3), worden de project-
kosten direct geupdate. Wanneer in het totale project dijksecties zitten die nog niet berekend
zijn, worden hier geen rekenresultaten getoond.
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Figuur 2.10: Overzicht resultaten totale project

2.4.2 Kunstwerktypes

Individuele kunstwerken van een bepaald type (bv. schutsluis, keersluis, ed.) die in een KOS-
WAT project worden meegenomen, moeten allen worden ingedeeld in een bepaalde groot-
teklasse (zie paragraaf 2.5.4). Voor ieder van deze type-grootteklasse combinaties is een
default kostencurve beschikbaar, de kosten van aanpassing van het kunstwerk als functie van
de waterstandsstijging op een dijkvak.

Deze tab geeft de default kostencurves voor kunstwerken die in de KOSWAT template be-
schikbaar zijn. Er is een totaal van 7 kunstwerktypes beschikbaar, in 5 verschillende grootte-
klassen. Door te klikken op de naam van het type (bijvoorbeeld ’Schutsluis – Groot’) verschijnt
in de onderste tabel het bedrag dat benodigd is om deze constructie op te hogen voor een
toename in waterniveau van x cm (zie figuur 2.11). Hierbij wordt ervan uitgegaan dat een
kunstwerk in de uitgangssituatie exact op orde is met de referentiesituatie.

De kostencurves zijn ontleend aan het project Waterveiligheid 21e eeuw (WV21) en onder-
bouwd in een analyse door Arcadis, Royal Haskoning en Fugro op basis van een analyse van
26 kunstwerken in Nederland.
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Figuur 2.11: Kostencurves voor diverse kunstwerktypes

2.4.3 Dijksectie

Wanneer in de tabel Dijksectie (paragraaf 2.5.2) een bepaalde dijksectie wordt geselecteerd,
verschijnen in het eigenschappen scherm de eigenschappen van de betreffende sectie in een
6-tal verschillende tabs (zie onderstaande figuur). Deze tabs worden allen beschreven in
(paragraaf 3.6.1) t/m (paragraaf 3.6.6)
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Figuur 2.12: Eigenschappen per dijksectie

2.4.4 Legenda

Wanneer in het kaartvenster op de knop legenda wordt gedrukt in de menubalk, wordt deze
geopend in het eigenschappen scherm. De verschillende lagen in de kaart kunnen hier ten
opzichte van elkaar verplaatst worden (slepen), daarnaast zijn verschillende opties voor het
opmaken van een kaartlagen te vinden onder de rechtermuisknop.
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Figuur 2.13: Legenda bij kaart in eigenschapvenster

2.5 Tabellen

Het vierde venster, onderin het scherm, bestaat per default uit een drietal tabbladen, namelijk
’tabellen’, ’meldingen’ en ’uitvoer’. Deze paragraaf behandelt het tabblad ’tabellen’.

2.5.1 Algemeen

Bovenin de tabbladen dijkringen en dijksectie zit een menubalk.

Figuur 2.14: Menubalk in tabelvenster

Het menu bevat de volgende knoppen, zie figuur 2.14.

� Knippen, Kopiëren en Plakken: standaard functionaliteit voor knippen, kopiëren en
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plakken van data tussen de ene cel en de andere.
� Aanpassen: Automatisch aanpassen van de breedte van alle kolommen zodanig dat

de data in de kolommen past.
� Aanpassen: Aanpassen van data in meerdere cellen tegelijk, zie verder voor een uit-

voerigere beschrijving van deze functionaliteit.
� Exporteren: Exporteren van de data in de tabel voor gebruik in een externe applicatie.
� Categorie: Hiermee worden bepaalde kolommen in de tabel zichtbaar gemaakt danwel

verborgen

In de tabel ’Kunstwerken’ zijn daarnaast nog een tweetal buttons te vinden waarmee kunst-
werken toegevoegd, danwel verwijderd kunnen worden.

Door tijdens het klikken met de muis de CTRL-toets op het toetsenbord in te drukken kunnen
in de tabel meerdere cellen met data tegelijk worden geselecteerd, door het indrukken van
SHIFT+CTRL kan een hele reeks worden geselecteerd. Op de geselecteerde cellen kan in
één keer een zelfde bewerking gedaan worden door het indrukken van de ’Aanpassen’ knop in
de toolbar. Zo kan bijvoorbeeld in één keer een vinkje worden gezet in meerdere checkboxes
(figuur 2.15).

Figuur 2.15: Selecteren van meerdere dijkvakken tegelijk

Bij datavelden heeft een gebruiker meerdere opties tot z’n beschikking, zie figuur 2.16:

� =: alle geselecteerde cellen gelijkstellen aan een gespecificeerde waarde
� +: bij alle geselecteerde cellen de gespecificeerde waarde optellen
� -: van alle geselecteerde cellen de gespecificeerde waarde aftrekken
� *: alle geselecteerde cellen met de gespecificeerde waarde vermenigvuldigen
� /: alle geselecteerde cellen delen door de gespecificeerde waarde
� <: de geselecteerde cellen moeten een waarde hebben die kleiner is dan de gespecifi-

ceerde waarde. Cellen met een waarde die groter is, worden automatisch verlaagd.
� >: de geselecteerde cellen moeten een waarde hebben die groter is dan de gespecifi-

ceerde waarde. Cellen met een waarde die kleiner is, worden automatisch verhoogd.
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Figuur 2.16: Bewerken van gegevens van meerdere dijkvakken tegelijk

Door op een bepaalde kolomkop van de tabel te klikken wordt de tabel gesorteerd in oplo-
pende volgorde. Door nogmaals op de kolomkop te klikken in aflopende volgorde. De kolom-
men kunnen in een andere volgorde gezet worden door ze te verslepen. Op een kolom kan
ook een filter gezet worden. Wanneer met de muis over een kolom bewogen wordt, verschijnt
in de rechterbovenhoek een filter-knopje (zie figuur 2.17).

Figuur 2.17: Zet een filter op de tabel

2.5.2 Dijkringen

De tab ’Dijkringen’ bevat informatie over de verschillende dijkringen binnen een KOSWAT
project (figuur 2.18). De informatie bestaat uit de naam van de dijkring en het corresponde-
rende dijkringnummer. Aan de linkerkant van het scherm kan een vinkje worden gezet bij de
dijkringen die worden meegenomen in de berekening (paragraaf 3.3).
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Figuur 2.18: Overzicht van aanwezige dijkringen in het project

2.5.3 Dijksectie

De tweede tab, ’Dijksecties’, bevat een tabel met alle dijksecties die onderdeel uitmaken van
het KOSWAT project (figuur 2.19). De informatie in deze tabel komt overeen met de informatie
in het ’Eigenschappen’ venster, dat tevoorschijn komt wanneer één van de dijksecties in deze
tabel of op de kaart geselecteerd wordt (paragraaf 2.4.3). De velden in de tabel ’Dijksecties’
worden op deze plek niet verder beschreven, maar komen aan de orde in paragraaf 3.6 en
verder.

Figuur 2.19: Overzicht van aanwezige dijksecties in het project

2.5.4 Kunstwerken

In de tab ’Kunstwerken’ (figuur 2.20) wordt weergegeven welke kunstwerken aanwezig zijn in
het KOSWAT project. Kunstwerken worden op basis van hun coördinaat automatisch gekop-
peld aan de dijksectie waarin ze vallen, de kosten van aanpassing van de kunstwerken wordt
in de resultaten van de betreffende dijksectie gepresenteerd. Kunstwerken worden zichtbaar
op de kaart wanneer er voldoende wordt ingezoomd. Voor de kunstwerken zijn de volgende
eigenschappen te vinden in de tabel:

� Naam
� Id: een unieke aanduiding van het betreffende kunstwerk
� Het x-coördinaat (RD-stelsel)
� Het y-coördinaat (RD-stelsel)
� Het kunstwerktype, zie paragraaf 2.4.2
� De beheerder van de constructie
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Figuur 2.20: Overzicht van kunstwerken in het project

2.5.5 Uitvoerpunten

In de tab ’Uitvoerpunten’ (figuur 2.21) wordt weergegeven welke uitvoerpunten aanwezig zijn
in het KOSWAT project. Uitvoerpunten worden als blauwe bolletjes zichtbaar op de kaart
wanneer er voldoende wordt ingezoomd.

Figuur 2.21: Overzicht van uitvoerpunten
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2.6 Meldingen

Voordat een berekening in KOSWAT kan worden gestart, doet de software een validatieslag
op de invoergegevens. Het kan voorkomen dat een berekening niet kan worden gestart, de
’Run’ knop is op dit moment nog inactief. Als dit het geval is, geeft de tab met ’Meldingen’
aan wat het probleem is. Een gebruiker kan vanuit het meldingenscherm doorklikken naar
de betreffende dijksectie om de fout te herstellen, of kan een door de software voorgestelde
herstelactie uitvoeren.

Figuur 2.22: Validatiemeldingen bij berekening

2.7 Uitvoer

Bij het importeren van data in de applicatie krijgt de gebruiker een terugmelding in een pop-
up scherm (paragraaf 3.1.2), de data wordt daarnaast gepresenteerd in de tab ’Uitvoer’ (fi-
guur 2.23).

Figuur 2.23: Terugmeldingen uit importprocedures

Deltares 23 van 75



KOSWAT, Handleiding

24 van 75 Deltares



3 Maken van een KOSWAT project

3.1 Starten van een nieuw project

3.1.1 Openen van een template

Bij het openen van de applicatie wordt een scherm getoond waarin een gebruiker moet aange-
ven op basis van welk van de meegeleverde projecttemplates een nieuw project wordt gestart
(zie figuur 3.1). Hierbij kan tevens door het zetten van een vinkje worden aangegeven of deze
vraag iedere keer opnieuw moet worden gesteld, of dat in het vervolg van dezelfde keuze
moet worden uitgegaan. Deze default keuze kan altijd ongedaan worden gemaakt door in het
menu Gereedschap>Opties bij de instelling ’Laatst gekozen project template onthouden’ het
vinkje uit te zetten.

In de templates zijn naast de default rekeninstellingen de eenheidsprijzen en opslagfactoren
vastgelegd. Met de applicatie zijn diverse templates meegeïnstalleerd die enkel van elkaar
verschillen in het gebruikte prijspeil. KOSWAT maakt gebruik van het prijzenboek opgesteld
door het Expertise Centrum Kosten en Baten (ECK-B) van het Deltaprogramma, dat valt onder
Rijkswaterstaat Dienst Infrastructuur. In de template zitten verder de achtergrondkaart en de
ligging van de dijkringlijnen (volgens het RWS basisbestand dijkringlijnen versie 4.0).

Figuur 3.1: Kiezen van een projecttemplate bij opstarten software

Wanneer een nieuwe projecttemplate beschikbaar is, zal deze via internet naar de gebruikers
worden verspreid. Bij het opstarten wordt in dat geval de vraag gesteld of een nieuwe tem-
plate gedownload dient te worden. De templatebestanden worden opgeslagen op de lokatie:
c:\programdata\Deltares\Koswat\*.kwx.

Een nieuw project op basis van één van de meegeleverde templates kan eveneens gestart
worden via de menuoptie Bestand>Nieuw, of met de betreffende knop in de menubalk.

Een gebruiker kan ervoor kiezen de standaard rekeninstellingen te overschrijven en z’n eigen
template bestand aan te maken. Dit dient dan wel iedere keer handmatig geopend te worden
wanneer KOSWAT wordt opgestart, zie paragraaf 3.2.
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3.1.2 Importeren invoerbestanden

Om na het starten van de template data te importeren binnen het KOSWAT project kan de
menu optie Bestand > Importeer gebruikt worden. Dan verschijnt het volgende scherm:

Figuur 3.2: Importeren van data in KOSWAT

Er kunnen vijf bestanden in het project worden geladen, waarvan er drie essentieel zijn om
een berekening te kunnen uitvoeren. In appendix C is exact beschreven aan welke eisen de
diverse invoerbestanden moeten voldoen (welk format wordt verwacht, en welke datavelden
moeten de bestanden bevatten):

Naam Inhoud Verplicht? Bestand
Ligging dijk-
secties

Bevat de geografische ligging van de dijksec-
ties in het project. Bij importeren van de sha-
pefile worden de dijksecties gekoppeld aan
de omgevingsdatabase die in de applicatie
beschikbaar is. De dijksecties dienen ieder
een unieke sectiecode te hebben.

Ja .shp

Data dijksec-
ties

De eigenschappen van de dijksecties waar-
mee het project kan rekenen. De dijksecties
hebben een individuele code die correspon-
deert met de codes in de Dijkvakshape.

Ja .csv

Kunstwerken Gegevens over kunstwerken die in het pro-
ject worden meegenomende en versterkt
moeten worden gegeven een bepaalde wa-
terstandsstijging.

Nee .csv

Dijkbekleding Kostencurves voor de aanpassing van dijkbe-
kleding gegeven een bepaalde waterstands-
stijging. Deze kosten dienen buiten KOSWAT
om bepaald te worden.

Nee .shp
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Scenarios (Hydraulische) scenario’s waarmee gere-
kend wordt, bijvoorbeeld verschillende kli-
maatscenario’s of ruimtelijke maatregelen in
het watersysteem. Wanneer een verster-
kingsmaatregel bepaald wordt met DAM (pa-
ragraaf 3.6.4) dienen in deze bestanden ook
de veiligheidsfactoren ten aanzien van stabi-
liteit en piping te worden opgenomen (appen-
dix C)

Ja map met
.csv be-
standen

Voor de shape met de ligging van de dijksecties en de data van de dijksecties kan vanuit
dit scherm een template (sjabloon) geëxporteerd worden op basis waarvan de gebruiker zijn
invoerbestanden kan aanmaken. Klik hiervoor op de link ’Sla sjabloon op’ rechts van het
betreffende invoerveld.

Om een bestand te laden, klik op de witte balk naast het te laden bestand. Er verschijnen
dan drie puntjes, door erop te klikken kan naar het betreffende bestand worden gebladerd
(figuur 3.2). Nadat tenminste de dijksectie ligging, de dijksectie data en de scenario’s zijn
geselecteerd, kan de knop ’Importeer’ worden gedrukt. De bestanden worden geimporteerd
en er kan gerekend worden zoals in de rest van dit hoofdstuk is beschreven.

Na het importeren krijgt de gebruiker een terugmelding of de import geslaagd is of niet. Een
groot aantal fouten in de invoerbestanden zal door KOSWAT worden afgevangen, hiervan
wordt melding gemaakt in het betreffende uitvoerscherm (figuur 3.3). De meldingen komen
ook terug in het tabblad ’Uitvoer’ (paragraaf 2.7).

Figuur 3.3: Importeren van data in KOSWAT
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3.2 Projectbestanden (*.kwx)

Na het importeren van invoerbestanden kan een project worden opgeslagen als *.kwx file
met de buttons ’opslaan’ of ’opslaan als... ’. De eerder beschreven invoerbestanden zijn
hierna niet meer nodig. Alle informatie is weggeschreven in een projectbestand, dat later weer
geopend kan worden, en makkelijk uitgewisseld kan worden tussen gebruikers onderling.

Een bestaand project kan in de applicatie op meerdere manieren worden geopend

� Via het menu Bestand>Openen kan een bestaand project worden opgezocht in win-
dows explorer.

� Via het icoontje in het beginscherm ( ) kan ook een bestaand project worden geopend

3.3 Dijksecties selecteren voor berekening

Na het importeren van gegevens (paragraaf 3.1.2) dient in de user interface aangegeven te
worden welke dijksecties daadwerkelijk in een berekening worden meegenomen. Wanneer
dijksecties niet geselecteerd worden, worden ze niet berekend, en komen de kosten niet terug
in de berekeningsresultaten en de exports.

Selectie per dijkring Selectie per dijksectie

Figuur 3.4: Selecteren dijksecties voor de berekening

Selecteren van een dijksectie kan op de volgende manieren:

� Per dijkring: in de eerste tab het venster Tabellen (paragraaf 2.5.2) kan op dijkringni-
veau worden gekozen welke dijkringen meerekenen in de analyse (figuur 3.4). Als je
een dijkring selecteert, worden alle dijkvakken in die dijkring automatisch geselecteerd.

� Per dijksectie: in de tweede tab van het venster Tabellen (paragraaf 2.5.3) kan op
dijkvak worden gekozen welke dijkvakken meerekenen in de analyse (figuur 3.4). Dit
kan uiteraard ook vanuit het ’Eigenschappen’ venster bij de betreffende dijksectie (pa-
ragraaf 3.6.1).

� Vanuit de kaart: door in menubalk in het kaartvenster op de knop ’Wissel selectie’
(plus-symbool) te klikken kan een dijksectie in de kaart aan- of uitgeschakeld worden
voor de berekening (paragraaf 2.2).

3.4 Rekeninstellingen - Eenheidsprijzen

De kostengegevens in de eenheidsprijzenvensters zijn afkomstig van het Expertisecentrum
Kosten en Baten (ECK-B) van het Deltaprogramma, dat valt onder Rijkswaterstaat Dienst
Infrastructuur. Deze eenheidsprijzen zijn uitvoerig onderbouwd. In de volgende paragrafen
worden de gegevens in de diverse schermen beschreven.
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3.4.1 Maatregelen in grond

In dit venster zijn eenheidsprijzen weergegeven die te maken hebben met het grondwerk van
een dijkversterking (zie figuur 3.5):

� Aanvoeren en verwerken teelaarde: eenheidsprijs voor aanvoeren en verwerken van
teelaarde [e per m3]

� Aanvoeren en verwerken onderlaag: eenheidsprijs voor aanvoeren en verwerken van
de onderlaag van de bekleding (klei) [e per m3]

� Als toplaag in profiel verwerken: bestaande grasmat van het oude profiel verwijderen
en hergebruiken in nieuw profiel [e per m3]

� Als kernmateriaal in profiel verwerken: Eenheidskosten om bestaand materiaal te her-
gebruiken in de kern van het nieuwe dijkprofiel [e per m2]

� Aanvoeren en verwerken kernmateriaal [e per m3]
� Afvoeren overtollig materiaal: verwijderen van overbodig materiaal [e per m2]
� Profileren toplaag/eindprofiel: in vorm brengen van de grasmatlaag [e per m2]
� Profileren onderlaag: in vorm brengen van de deklaag [e per m2]
� Profileren kernmateriaal: in vorm brengen van de dijkvulling [e per m2]
� Oppervlaktebewerking maaiveld: aanpassingen aan de buitenzijde van het dijkprofiel

die benodigd zijn voor uitbreiding van het dijkprofiel [e per m2]

Figuur 3.5: Eenheidsprijzen voor maatregelen in grond

3.4.2 Infrastructuur

Dit betreft eenheidsprijzen voor ingrepen die te maken hebben met aanpassing van het be-
staande wegennet (figuur 3.6):

� Verwijderen weg type: kosten voor verwijderen van type weg in e per m2

� Aanbrengen weg type: kosten voor het aanbrengen van een type weg in e per m2
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Er wordt gespecificeerd voor 5 verschillende wegtypen. Het type weg is afhankelijk van de
wegbreedte:

� Type 1: wegen met een effectieve rijbreedte kleiner dan 2 m (fietspad)
� Type 2: wegen met een effectieve rijbreedte van 2 - 4 m (kleine lokale toegangsweg)
� Type 3: wegen met een effectieve rijbreedte van 4 - 7 m (tertiaire of secundaire weg)
� Type 4: wegen met een effectieve rijbreedte groter dan 7 m (autoweg)
� Type 5: wegen met onbekende breedte. Bij een inventarisatie van dit type wegen, bleek

het vaak te gaan om wegen in woonwijken

De effectieve wegbreedte kan afwijken van de wegbreedte die uiteindelijk vervangen dient te
worden bij een versterking. Denk aan vluchtstroken, parkeerstroken, e.d. De daadwerkelijke
oppervlakte van een te vervangen weg wordt berekend door de lengte ervan te vermenigvul-
digen met de breedte die is gespecifiveerd in de systeem aannamen (paragraaf 3.5.4)

Figuur 3.6: Eenheidsprijzen voor aanpassing infrastructuur

3.4.3 Opslagfactoren

In KOSWAT worden opslagfactoren (figuur 3.7) gehanteerd die gebruikt worden om van di-
recte bouwkosten naar investeringskosten te komen volgens de SSK systematiek. In deze
tab worden de opslagfactoren gedefiniëerd, afhankleijk van het type maatregel en de moei-
lijkheidsgraad. Verder moet gekozen worden of er met of zonder BTW wordt gerekend en
zo ja, met welk percentage. In deze tab wordt ook het prijspeiljaar ingevuld dat op diverse
plaatsen in de aplicatie wordt getoond. LET OP: wijzigen van het prijspeiljaar leidt niet tot een
automatische update/indexering van de eenheidsprijzen!

Er zijn vier typen opslagfactoren, die gegeven worden voor een situatie waarin wel/niet BTW
wordt meegenomen:
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� Grondmaatregelen: Deze opslagfactor wordt toegepast bij een maatregel die volledig
wordt uitgevoerd in grond.

� ConstructiefGrond: Deze opslagfactor wordt toegepast op het grondwerk in geval van
een constructieve maatregel.

� ConstructiefConstructie: Deze opslagfactor wordt toegepast op het constructieve deel
van een constructieve maatregel, dus op de wand (CB-wand, damwand, diepwand,
kistdam) zelf.

� Vastgoed: deze opslagfactoren gelden voor het verwerven van vastgoed.

Per maatregel is er een opslagfactor gegeven voor een makkelijke, normale en moeilijke situ-
atie. De moeilijkheidsgraad moet per projectonderdeel gedefinieerd worden. Dat gaat onder
Projectaannamen > Complexiteit. Dit staat beschreven in paragraaf 3.5.5.

Figuur 3.7: Opslagfactoren

Deltares 31 van 75



KOSWAT, Handleiding

3.4.4 Constructieve maatregelen

In deze tab worden de (samengestelde) eenheidskostencurves van constructieve maatrege-
len beschreven. Achter elke constructieve maatregel zit een gefitte kostencurve die afhanke-
lijk is van de inheidiepte van de constructie. De factoren in deze tabel (figuur 3.8) geven de
parameters in die gefitte kostenfunctie weer, onderbouwd door het Expertisecentrum Kosten
(RWS). De wiskundige beschrijving van de functie is als volgt:

f (x) = ax4 + bx3 + cx2 + dx+ z + fxg + heix+ j ln (x)

waarbij x de inheidiepte is. Voor verschillende constructies (kistdam, damwand) spelen ver-
schillende factoren een rol, waardoor sommige van de factoren op nul staan.

Figuur 3.8: Factoren van kostencurves van constructieve elementen

3.5 Rekeninstellingen - Systeemaannamen

Voor elk project wordt een groot aantal aannamen gedaan. Deze aannamen hebben betrek-
king op de eigenschappen van de bestaande dijk, de bestaande omgeving van de dijk, en
eigenschappen van de dijkversterking.

3.5.1 Dijkprofiel

In deze tab worden de eigenschappen beschreven waarmee gerekend wordt bij het ontwerp
van de huidige en toekomstige dijkopbouw (figuur 3.9). Deze eigenschappen zijn gebaseerd
op analyse van technische eigenschappen. Er wordt afgeraden deze parameters aan te pas-
sen zonder een duidelijke technische onderbouwing hiervan.
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Figuur 3.9: Algemene rekeninstellingen met betrekking tot het dijkprofiel

De eigenschappen in deze tab zijn als volgt:

� Dikte toplaag grasbekleding [m]: De toplaag van de grasbekleding, het deel waarin
het gras z’n wortelstelsel heeft gevormd, wordt verwijderd van het oude profiel en waar
mogelijk teruggebracht in het nieuwe dijkprofiel.

� Dikte onderlaag grasbekleding [m]: De onderlaag van de gras bekleding (kleilaag)
wordt van het oude profiel verwijderd en als kernmateriaal verwerkt in het nieuwe profiel.

� Minimale taludhelling binnentalud [cot]: Deze waarde kan worden aangepast als
bijvoorbeeld gerekend wordt met Deltadijken en er minstens een binnentaludhelling
van 1:3 nodig is. De waarde wordt ingevuld als cotangens (dus in dit geval 3). Als deze
waarde op 0 staat, wordt de helling van het binnentalud minimaal gelijk gesteld aan de
helling in de uitgangssituatie.

� Minimum hoogte pipingberm [m]: de minimale hoogte van de pipingberm om kwel te
voorkomen.

� Bermlengte voor toename hoogte [m]: vanaf deze lengte pipingberm zal de hoogte
van de berm gaan toenemen boven het minimum.

� Mate toename bermhoogte/lengte [m/m]: na overschrijding van de bermlengte voor
toename hoogte (zie vorige) neemt de hoogte van de pipingberm toe met deze waarde
per extra meter berm

� Maximale hoogte pipingberm [-]: hoe hoog mag de pipingberm maximaal worden
t.o.v. dijkhoogte (bijv. 0.5*totale dijkhoogte)

� Maximale versteiling binnentalud [cot]: de hellingshoek tot waar versteild mag wor-
den aan de binnenkant van de dijk (oplossen stabiliteitsprobleem met behulp van een
stabiliteitswand). De nieuwe helling moet minimaal een hoek hebben van 1 op X (X hier
in te vullen).
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3.5.2 Constructieve oplossingen

Onder constructieve oplossingen worden de ontwerpinstellingen geduid die te maken hebben
met aanleg van constructies in een waterkering (figuur 3.10).

Figuur 3.10: Algemene rekeninstellingen met betrekking tot constructieve oplossingen

� Maximale lente constructie [m]: De maximale (verticale) lengte van een constructief
element (damwand/diepwand, etc)

� Overgang CB wand naar damwand [m]: In het geval er een kwelscherm wordt bere-
kend, tot welke (verticale) lengte wordt gekozen voor een CB wand, en wanneer voor
een damwandscherm.

� Minimale lengte CB wand [m]: de minimale (verticale) lengte van een cementbento-
nietwand.

� Overgang damwand naar diepwand [m]: de maximale lengte van een damwand (m)
(tbv stabiliteit) voordat overgegaan wordt op een diepwand.

� Minimale lengte damwand [m]: de minimale (verticale) lengte van een damwand
� Minimale lengte kistdam [m]: de minimale (verticale) lengte van een kistdam
� Minimale kruinbreedte voor kistdam b=6m [m]: de minimale breedte van de kruin

van de dijk voordat wordt gekozen voor een oplossing met een kistdam van 6 m breed.
Bij een kleinere kruinbreedtes wordt gekozen voor een kistdam met een breedte van 4
m.

� Minimale kruinbreedte voor kistdam b=8m [m]: de minimale breedte van de kruin
van de dijk voordat wordt gekozen voor een oplossing met een kistdam van 8 m breed

3.5.3 Toepassing constructies

Wanneer op een bepaalde plaats geen ruimte is voor een oplossing in grond, stapt KOSWAT
automatisch over op een constructieve oplossing. In deze tab kan worden aangegeven welke
objecten (bebouwing, spoorwegen en/of waterlichamen) een grens stellen aan de beschik-
bare ruimte. Tevens worden in dit scherm keuzes gemaakt over de lengte van overgangscon-
structies en in welke gevallen twee ogenschijnlijk los van elkaar liggende constructies als één
geheel moeten worden uitgevoerd.
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Figuur 3.11: Algemene rekeninstellingen voor toepassing van constructies

Er zijn vijf rekeninstellingen:

� Minimale afstand tussen constructies [m]: De minimale afstand tussen constructies
in meters. Als de afstand tussen twee constructies, bijvoorbeeld twee dijkstrekkingen
met damwanden, kleiner is dan deze afstand, wordt ook het overbruggende deel als
damwand uitgevoerd;

� Breedte overgangsconstructie [m]: aan het begin en einde van een constructie wordt
de constructie nog een beetje verlengd om een soepele overgang te creëren naar an-
dere oplossingen. Deze parameter bepaalt over welke afstand deze overgangscon-
structie wordt aangelegd.

� Bebouwing: op basis van ruimtelijke analyse is vastgesteld waar gebouwen liggen die
een belemmering vormen voor dijkversterking. Aanvinken van deze optie zorgt ervoor
dat bebouwing in de analyse wordt meegenomen. Door ruimtebeperking zal vaker
moeten worden gekozen voor een constructieve oplossing.

� Spoorwegen: aanvinken van deze optie zorgt ervoor dat rekening wordt gehouden met
de aanwezigheid van bestaande spoorlijnen. Door ruimtebeperking zal vaker moeten
worden gekozen voor een constructieve oplossing.

� Waterpartijen: aanvinken van deze optie zorgt ervoor dat rekening wordt gehouden
met de aanwezigheid van open water, er wordt een constructieve oplossing gekozen
als grote waterlichamen in de weg liggen. Water is vaak eigendom van een beheerder,
dus worden in dit geval vooral extra kosten geformuleerd om water geschikt te maken
voor dijkversterking, bijvoorbeeld door (deels) dichten/omleiden van water.
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3.5.4 Infrastructuur

In KOSWAT wordt rekening gehouden met een aanwezige infrastructuur in een gebied, omdat
dijkversterking vaak gepaard gaat met aantasting, aanpassing en vervanging van bestaande
infrastructuur. Voor een inschatting van kosten hiervan is er een combinatie beschikbaar van
ruimtelijke analyse en eigenschappen van infrastructuur (figuur 3.12).

Figuur 3.12: Algemene rekeninstellingen met betrekking tot infrastructuur

Deze tab beschrijft de breedte van vijf verschillende typen wegen, zoals deze zijn gedefinieerd
in de TOP10NL topografische kaarten. Weg type 1 komt overeen met een fietspad, type 2 is
een kleine lokale toegangsweg, type 3 een tertiaire of secundaire weg, en type 4 een autoweg.
Bij type 5 is de klasse onbekend, maar analyses wijzen uit dat dit meestal gaat om wegen in
woonwijken ed. Deze vijf wegen zijn gekenmerkt door wegbreedte. Deze wordt gebruikt om
de oppervlakte van wegverharding te berekenen die vervangen danwel hersteld moet worden
in geval van een dijkverzwaring.

Voor de maatregelen kunnen nog drie verdere keuzes worden gemaakt:

� Zijn er kosten aan infrastructuur op de kruin bij geen dijkverhoging?: Er kan ge-
redeneerd worden dat, als er alleen een pipingberm wordt aangebracht en niet wordt
opgehoogd, de weg bovenop de kruin niet vervangen hoeft te worden. In de praktijk
blijkt echter, dat de werkzaamheden op de dijk en het gebruik van zwaar materieel
dusdanig invloed hebben op het wegdek, dat aansluitend de weg op de kruin vaak als-
nog vervangen moet worden. Er kan ook gekozen worden alleen de bestaande weg te
herstellen.

� Infrastructuur buitendijks meenemen?: moet bij een binnendijkse versterking de
infrastructuur in een buitendijkse zone meegenomen worden in de kostenramingen?
Soms komen dijkringlijn en weg niet geheel overeen in de GIS-bestanden. Door instel-
len van deze buffer worden wegen, die binnen een afstand van x m van de dijkringlijn
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liggen, meegenomen alsof ze er bovenop liggen. Het is dus een mogelijkheid om toch
goed te ramen, als er slordigheden zitten in de inputbestanden of als er een kleine off-
set is tussen de beide bestanden. Hier wordt een keuze gemaakt of deze buffer wel of
niet wordt toegepast

� Bufferzone buitendijks [m]: Definitie van de gehanteerde buffer zone rondom de dijk-
weg, zoals aangewezen onder punt 2. Default staat op 10 m.

3.5.5 Complexiteit

Voor alle maatregelen worden in KOSWAT allereerst de directe bouwkosten bepaald. Om van
directe bouwkosten naar uiteindelijke investeringskosten te komen wordt gewerkt met een op-
slagfactor (paragraaf 3.4.3). Deze is afhankelijk van de moeilijkheidsgraad van de maatregel
op een bepaalde plek. Zaken die de moeilijkheidsgraad beïnvloeden, zijn bijvoorbeeld hoe
toegankelijk een dijk is voor het nemen van maatregelen (loopt er een weg langs de voet
van de dijk) en hoe gemakkelijk grondverwerving gaat. Voor alle (deel)maatregelen dient een
moeilijkheidsgraad te worden gekozen per project (figuur 3.13).

Categorie Type Toelichting
Grondmaatregel Grondwerk Moeilijkheidsgraad voor grondwerk bij een maat-

regel in grond
Aankoop grond Aankoop grond bij maatregel in grond

Kwelscherm Grondwerk Moeilijkheidsgraad voor grondwerk bij aanleg
van een kwelscherm

Constructie Moeilijkheidsgraad kwelscherm zelf
Aankoop grond Aankoop grond voor aanleg kwelscherm

Stabiliteitswand Grondwerk Moeilijkheidsgraad voor grondwerk bij aanleg
damwand

Constructie Moeilijkheidsgraad damwand zelf
Aankoop grond Aankoop grond voor damwand

Kistdam Grondwerk Moeilijkheidsgraad voor grondwerk bij aanleg
kistdam

Constructie Moeilijkheidsgraad kistdam zelf
NB: voor de kistdam wordt geen moeilijkheids-
graad voor aankoop grond gegeven, omdat een
kistdam alleen wordt toegepast als er geen
ruimte is om maatregelen in grond te treffen

Overige type 1 Constructief in uitgangssituatie - eenvoudig
constructieve type 2 Constructief in uitgangssituatie – normaal
maatregelen type 3 Constructief in uitgangssituatie – complex
Infrastructuur Aanleg weginfra-

structuur
Moeilijkheidsgraad voor de aanleg van weginfra-
structuur
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Figuur 3.13: De complexiteit van een maatregel bepaalt welke opslagfactor wordt toege-
past
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3.5.6 Kosten overig constructief

In een visuele analyse met behulp van Google Earth zijn dijksegmenten geidentificeerd die
in de beginsituatie reeds een constructief karakter hebben. Denk hierbij aan eenvoudige
kadeconstructies, maar ook aan complexe historische stadsfronten. Deze segmenten zijn
vastgelegd in de omgevingsdatabases en kunnen door een gebruiker niet aangepast worden.

De reguliere versterkingen die KOSWAT op een dijksectie berekent, kunnen niet toegepast
worden op dit soort segmenten. Omdat KOSWAT op deze dijkstrekkingen feitelijk geen juiste
kostenberekening kan maken, maar je de kosten wel graag inzichtelijk zou hebben in een
project is ervoor gekozen de kostenramingen van een kistdam als hier leidend te nemen.
Voor eenvoudige constructies wordt bijvoorbeeld 0.75x de kosten voor een kistdam gerekend,
voor ’normale’ constructies 1x de kistdam en voor uitzonderlijk moeilijke constructies 1.5x de
kistdam (zie factoren in figuur 3.14). De kosten van deze secties zijn welliswaar gerelateerd
aan de kosten van de kistdam, voor het ontwerp kan een totaal andere oplossing worden
gekozen (denk hier aan innovatieve oplossingen, demontabele wanden, ed). Het handelt hier
echt om een eerste budgetraming.

Figuur 3.14: Kosten van dijkstrekkingen met een constructieve uitgangssituatie

3.6 Rekeninstellingen - Instellingen per dijkvak

3.6.1 Dijksectie

Dit scherm laat de algemene eigenschappen zien van het geselecteerde dijksegment, zie
figuur 3.15.
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Figuur 3.15: Algemene eigenschappen van de geselecteerde dijksectie

Een beschrijving van de velden in dit scherm:

� Sectiecode: de unieke ID waarmee de dijksectie wordt aangeduid
� Sectienaam: een willekeurige aanduiding waarmee de gebruiker de dijksectie makke-

lijk kan identificeren
� Is onderdeel berekening: de dijksectie maakt al dan niet onderdeel uit van de kosten-

berekening, zie paragraaf 3.3
� Dijkringnummer
� Dijkringnaam
� Dijkringdeel: een eventuele verdere opdeling van de dijkring
� Dijkringtraject: een eventueel verdere opdeling van het dijkringdeel
� Beheerder
� Categorie: de categorie, in KOSWAT keuze uit a-, en c-keringen. Deze indeling betreft

alleen primaire keringen, die zijn ingedeeld naar functie. Waterkeringen uit de cate-
gorie a zijn dijken, duinen en kunstwerken die rechtstreeks bescherming bieden tegen
de zee, de grote rivieren of andere grote wateren. b-keringen, zoals de Afsluitdijk of
Maeslantkering, verbinden waterkeringen uit de categorie a of c. c-keringen zijn wa-
terkeringen die indirect tegen buitenwater beschermen, zoals waterkeringen langs het
Noordzeekanaal.,

� Lengte: de lengte van de dijksectie
� Lengte overig constructief type 1: de lengte van de dijksectie met een constructieve

uitgangssituatie type 1, zie paragraaf 3.5.6. Lengte wordt pas weergegeven na bereke-
ning.

� Lengte overig constructief type 2: de lengte van de dijksectie met een constructieve
uitgangssituatie type 2, zie paragraaf 3.5.6. Lengte wordt pas weergegeven na bereke-
ning.
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� Lengte overig constructief type 3: de lengte van de dijksectie met een constructieve
uitgangssituatie type 3, zie paragraaf 3.5.6. Lengte wordt pas weergegeven na bereke-
ning.

� Grondprijs onbebouwd: grondaankoopprijs ter plekke van de maatregel in grond
� Grondprijs bebouwd: grondaankoopprijs ter plekke van een constructieve maatregel

3.6.2 Dwarsprofiel

De tab ’Dwarsprofiel’ (figuur 3.17) laat informatie zien over de ligging van het representatieve
dwarsprofiel van de dijksectie, en informatie over dimensies van de dijk in de uitgangssituatie,
zie figuur 3.16.

Figuur 3.16: Locaties van knikpunten in het dijkprofiel

Tevens is er informatie beschikbaar over de ondergrond. De term ’bovenzijde aquifer’ geeft de
bovenzijde van de watervoerende laag aan, ofwel de laag waarin zandtransport plaatsvindt
in geval van piping. Deze wordt gebruikt bij het bepalen van de diepte van maatregelen
(kwelscherm) tegen piping. De bovenkant van het pleistoceen geeft aan tot welke diepte een
damwand eventueel zou moeten worden ingeheid in verband met stabiliteit.
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Figuur 3.17: Eigenschappen met betrekking tot het dwarsprofiel van de dijk

3.6.3 Belasting

In de tab ’Belasting’ (figuur 3.18) wordt informatie gegeven over de hydraulische belasting
op een dijksectie, zowel in de uitgangssituatie als in de te berekenen scenario’s. Allereerst
wordt hier weergegeven aan welk hydraulisch uitvoerpunt uit de database de dijksectie zijn
informatie ontleent. De gebruiker kan een koppeling met een specifiek uitvoerpunt afdwingen
door deze handmatig te definieren in het bestand met data betreffende de dijksecties (csv),
zie paragraaf 3.1.2. Wanneer een gebruiker dit niet doet, zal KOSWAT automatisch een
koppeling leggen met het dichtstbijzijnde uitvoerpunt.
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Figuur 3.18: De belastingscenario’s aan de hand waarvan de versterking berekend wordt

De gebruiker kan dit vanuit de user interface veranderen door het vinkje uit te zetten en we-
derom handmatig een punt te kiezen uit de dropdown lijst (figuur 3.19). Te allen tijde kan een
gebruiker de automatische koppeling weer aanvinken.

Figuur 3.19: Handmatig koppelen van het hydraulisch uitvoerpunt

Op de kaart wordt de gemaakte koppeling tussen het maatgevend profielpunt (in groen) en het
uitvoerpunt (in blauw) weergegeven middels een stippellijntje, zie figuur 3.20. De betreffende
data komt pas tevoorschijn op de kaart wanneer er voldoende is ingezoomd.
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Figuur 3.20: Uitvoerpunten op de kaart

3.6.4 Versterking

In de tab ’Versterking’ worden rekeninstellingen gespecificeerd die de omvang van de dijkver-
sterkingsmaatregel bepalen. KOSWAT zal in de berekening eerst een toetsing uitvoeren op
het bestaande dijklichaam, om te bepalen of een dijksectie uberhaupt versterkt dient te wor-
den, gegeven de nieuwe ontwerpbelasting. Vervolgens worden de dimensies van het nieuwe
ontwerp bepaald.

Figuur 3.21: Rekeninstellingen versterkingsmaatregel

Allereerst worden een aantal instellingen gedaan die te maken hebben met de kruinhoogte
van het nieuwe dijklichaam (figuur 3.21):

� Factor klink: een dimensieloze parameter, die aangeeft hoeveel een dijk verhoogd
moet worden, om een meter dijkverhoging te realiseren, uitgaande van processen als
zetting en klink. Een factor 1.20 betekent dat aan iedere kruinverhoging 20% hoogte
wordt toegevoegd.
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� Waakhoogte: de minimale waakhoogte die in het ontwerp wordt toegepast. Kruin-
hoogte wordt minimaal aangelegd op waakhoogte boven maatgevend hoog water, zelfs
bij een minimale of geen golfoploop.

� Robuustheidstoeslag MHW: wordt er in het ontwerp een robuustheidstoeslag toege-
past op de ontwerpwaterstand (zie de Leidraad Rivieren)?

� Robuustheidstoeslag HBN: wordt er in het ontwerp een robuustheidstoeslag toege-
past op het hydraulisch belasting niveau, en wijkt deze eventuueel af van de robuust-
heidstoeslag op de waterstand?

� Buitendijkse versterking: standaard gaat KOSWAT er vanuit dat er niet buitendijks
versterk mag worden. De oplossing wordt dus altijd binnendijks gekozen. Wanneer
er wel buitendijks versterkt mag worden op een dijksectie kan dit aangegeven worden
middels het aanzetten van deze rekenoptie.

In figuur 3.22 wordt een en ander gevisualiseerd, met aan de linkerzijde de belasting op de
dijk, aan de rechterzijde de stappen om de nieuwe kruinhoogte te bepalen. De buitentalud-
helling wordt in KOSWAT altijd onveranderd gelaten, net als de breedte van de kruin van het
profiel in de uitgangssituatie. De dimensies ten aanzien van macrostabiliteit en piping volgen
onder de afbeelding.

Figuur 3.22: Dwarsdoorsnedescherm

Het ontwerp ten aanzien van macrostabiliteit en piping kan op drie verschillende manieren
bepaald worden. Het kan worden berekend via een methode met factoren, door een bere-
kening met de Deltares Dijk Analyse Module (DAM, versie 14.1.1.2), of door de dimensies
handmatig op te geven als gebruiker. Een keuze kan gemaakt worden in de dropdownbox
met de aanduiding ’Soort profielontwerper’.
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Versterkingsmaatregel macrostabiliteit en piping aan de hand van factoren

In figuur 3.22 is te zien dat de maatregel die benodigd is ten aanzien van macrostabiliteit en
piping wordt uitgedrukt in een toename van de dijkbasis van het huidig profiel. Voor macrosta-
biliteit wordt allereerst een taludverflauwing toegepast (in praktijk is het soms efficienter een
korte hoge berm aan te leggen, voor de kostenramingen is dit om het even), voor piping wordt
het daarna nog resterende deel opgelost met een pipingberm. In de versterking is de nieuwe
binnentaludhelling altijd minimaal gelijk aan de oude.

Figuur 3.23: Versterkingsmaatregel bepaald aan de hand van factoren

De versterking wordt gedefiniëerd door een viertal factoren, twee voor macrostabiliteit en twee
voor piping. Voor macrostabiliteit wordt de versterking als volgt bepaald:

� Stabiliteitsfactor dijkbasis: dit is de lengte aan dijkbasis ten behoeve van stabiliteit
die erbij komt voor iedere meter kruinverhoging.

� Extra stabiliteitslengte: dit is de lengte aan dijkbasis ten behoeve van stabiliteit die
erbij komt onafhankelijk van de kruinverhoging.

De versterkingsmaatregel voor macrostabiliteit wordt bepaald door de som van beide delen.
De tweede parameter kan bijvoorbeeld gebruikt worden als de dijk in de uitgangssituatie af-
gekeurd is. Deze parameter kan ook negatief ingevuld worden wanneer een dijklichaam een
zekere mate van oversterkte heeft, waarmee een correctie wordt toegepast op de eerste term.
Het nieuwe binnentalud wordt echter nooit steiler dan het bestaande binnentalud.

Voor piping gelden de volgende factoren:

� Pipingfactor dijkbasis: dit is de lengte aan dijkbasis ten behoeve van piping die erbij
komt voor iedere meter waterstandsstijging.

� Extra berm piping: dit is de lengte aan dijkbasis ten behoeve van piping die erbij komt
onafhankelijk van de waterstandsstijging.

Ook hier geldt dat de tweede term negatief ingevuld kan worden in geval van reststerkte in
het huidig profiel, bijvoorbeeld wanneer de ondergrond welliswaar pipinggevoelig is, maar er
een kwelwegverlengend voorland aanwezig is dat niet in de schematisaties is meegenomen.
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Versterkingsmaatregel macrostabiliteit en piping bepaald met DAM

Om de dimensies van een versterkingsmaatregel ten aanzien van macrostabiliteit en piping te
bepalen kan een gebruiker die bekend is met de Deltares - Dijk Analyse Module (DAM) hier-
van gebruik maken (figuur 3.24). KOSWAT is geschikt gemaakt om te werken met DAM versie
14.1.1.2. In DAM wordt uitgaande van het dijkprofiel, belastingssitiuaties en veiligheidsfacto-
ren die in KOSWAT zijn gespecificeerd, de versterkingsmaatregel bepaald op een bepaalde
dijksectie.

Figuur 3.24: Versterkingsmaatregel berekend met DAM

De stappen zijn als volgt:

� Importeren scenario’s: in de scenariofiles die geïmporteerd worden, moeten naast de
waterstand, het hydraulische belastingniveau en de bodemdaling ook de veiligheidsfac-
toren aangegeven worden, waarmee DAM straks de berekening gaat maken op een
dijkvak. Zie hiervoor paragraaf 3.1.2 en appendix C.

� Selecteren optie DAM: geef aan dat je de versterking wilt uitvoeren met DAM in het
versterkingsscherm van betreffende dijksectie.

� Exporteren DAM invoerfiles: hiermee worden vanuit KOSWAT DAM invoerfiles weg-
geschreven (*.DAMX), die vervolgens door een DAM expert in DAM berekend kunnen
worden. Zie figuur 3.25 en de nota bene onderaan deze paragraaf.

� Importeren gevalideerde DAM uitvoerfiles: hiermee worden de resultaten uit de be-
rekende DAMX files vanuit DAM terug ingelezen in KOSWAT, waarna automatisch de
dimensies van de versterkingsmaatregel worden bepaald.

� Kies of de uitkomsten uit DAM absoluut of relatief worden gebruikt: bepaalt of uit
de DAM resultaten de absoluut berekende dijkbasis wordt gebruikt, of enkel gewerkt
wordt met relatieve resultaten, de gevonden dijkbasistoename ten opzichte van een in
DAM berekende referentie. Stel: DAM berekent voor een bepaald hydraulisch scenario
een benodigde kwelweglengte van 80 meter, bij een huidige dijkbasis in KOSWAT van
20 meter, dan is absoluut benodigde berm in KOSWAT in de versterkingsmaatregel
60 meter. DAM doet echter ook een berekening van de referentiesituatie, en daaruit
zou kunnen blijken dat de dijkbasis van 20 meter uit de referentie van KOSWAT verre
van voldoet voor piping, maar dat misschien wel 60 meter nodig is in de referentie. In
praktijk kan dit voorkomen als het intreepunt voor piping als gevolg van een voorland
oid bijvoorbeeld 40 meter meer buitenwaarts ligt dan in de schematisaties, dit zit niet
in de KOSWAT schematisaties. Wanneer voor de optie ’DAM relatief’ wordt gekozen
wordt in KOSWAT enkel de relatieve toename van benodigde kwelweglengte uit DAM
gebruikt tussen het scenario en de referentie, in dit geval een berm van 80 - 60 = 20
meter
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Figuur 3.25: Exporteren DAM invoerfiles en importeren DAM resultaten

Enige achtergrond bij het bepalen van de versterkingsmaatregelen uit DAM: bij het exporteren
van de zogenaamde DAMX bestanden, wordt het geografisch midden van de KOSWAT dijk-
sectie gekoppeld aan een shape en een database met een probabilistisch ondergrondmodel.
Op een KOSWAT dijksectie kunnen zodoende meerdere verschillende ondergrondschemati-
saties voorkomen, ieder met een eigen kans van voorkomen. In DAM wordt per hydraulisch
scenario een berekening gemaakt voor iedere ondergrondschematisatie, dit levert voor ie-
dere dijksectie per ondergrondscenario een versterkingsmaatregel met een bepaalde kans
van voorkomen. In KOSWAT wordt gewerkt met maar één versterkingsmaatregel per hydrau-
lisch scenario, de versterkingsmaatregelen die in DAM berekend zijn worden voor stabiliteit
en piping gewogen gemiddeld over de ondergrondscenario’s. Stel DAM berekent voor bv. pi-
ping op een dijksectie over 75% van de lengte een dijkbasistoename van 10 meter en over
25% een toename van 20 meter, dan zal KOSWAT rekenen met een gewogen gemiddelde
dijkbasistoename van (0.75*10 + 0.25*20) = 12.5 meter

NB: Op het moment van schrijven van deze handleiding zijn enkel de ondergrondschemati-
saties van dijkring 10 beschikbaar met de installatie van KOSWAT. De overige dijkringen in
Nederland worden zo spoedig mogelijk beschikbaar gemaakt (huidige planning vóór de zomer
2014)

Versterkingsmaatregel macrostabiliteit en piping handmatig opgeven

Wanneer een gebruiker een andere bron heeft waarmee de toename van dijkbasis ten aan-
zien van macrostabiliteit en piping is bepaald, kan deze per scenario direct in de user inter-
face van KOSWAT worden ingevoerd (zie figuur 3.26). De berekening wordt vervolgens op
een normale manier uitgevoerd.

Figuur 3.26: Versterkingsmaatregel handmatig opgegeven door de gebruiker
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3.6.5 Dijkbekleding

In KOSWAT worden de kosten voor het aanpassen van dijkbekleding niet direct berekend.
Kosten voor aanpassen van bekleding uit een externe bron kunnen echter wel meegenomen
worden in de uiteindelijke raming. Hiertoe wordt onder de dijksectie indeling een shapebe-
stand ingeladen, waarin voor een dijkstrekking de kosten per strekkende meter dijk voor de
aanpassing van bekleding zijn gegeven, voor een reeks van waterstandsverhogingen. Zie
paragraaf 3.1.2 en appendix C voor een beschrijving hoe deze kosten aan het project worden
toegevoegd, en hoe het specifieke bestand eruit dient te zien.

Figuur 3.27: Kostencurve dijkbekledingskosten als functie van de waterstandsstijging

Het hart van de dijksectie waarvoor uiteindelijk de bekledingskosten bepaald worden, wordt
gekoppeld aan de onderliggende shape, en met behulp van de sectielengte worden de kos-
ten voor aanpassing van de bekleding op de specifieke dijksectie bepaald. Deze worden
weergegeven in de tab ’Dijkbekleding’, zie figuur 3.27. Voor ieder scenario wordt gekeken
welke waterstandsstijging er is, waarna de uiteindelijke investeringskosten voor dat specifieke
scenario uit de tabel worden geprikt.

3.6.6 Kunstwerken

Kunstwerken worden geïmporteerd zoals beschreven in paragraaf 3.1.2, waarna ze op basis
van het coördinaat aan de dichtstbijzijnde dijksectie worden gekoppeld. Kunstwerken die
verder dan 200 meter van een dijksectie af liggen, worden in het project niet meegenomen. In
de tabel die is weergegeven in de tab ’Kunstwerken’ is te zien welke kunstwerken binnen de
betreffende sectie vallen. Door middel van het kunstwerktype dat bij de import is meegegeven,
en de kostencurves die beschikbaar zijn per kunstwerktype in de template (paragraaf 2.4.2)
worden uiteindelijk aan de hand van de waterstandsstijgingen binnen een bepaald scenario
de investeringskosten bepaald.
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Figuur 3.28: Kunstwerken die meegenomen worden binnen de kostenberekening van de
dijksectie
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4 Rekenen en resultaten

4.1 Rekenen

Wanneer alle instellingen in het KOSWAT project zijn gedaan, is het tijd om te gaan rekenen.
Het aanzetten van een berekening kan via het menu Berekening>Start, of via de betreffende

button in de werkbalk bovenin het scherm ( ). Wanneer de button is uitgegrijsd ( ) zitter
er nog validatiefouten in het project, waardoor de berekening niet gedraaid kan worden. Kijk
in dat geval in de tabel ’Meldingen’ (paragraaf 2.6) om te zien wat er mis is.

Op hoofdlijnen volgt KOSWAT bij de berekening de volgende systematiek:

1 Per dijksectie en per scenario worden (uitgaande van de beginsituatie, de hydraulische
belasting en de rekeninstellingen) de dimensies van de ’versterkingsmaatregel in grond’
bepaald. Dit is een maatregel die zoals de naam al zegt volledig in grond wordt uitge-
voerd. De volgende stappen worden gevolgd bij het bepalen van de dimensies, zie ook
figuur 3.22:
� Bepalen aanleghoogte nieuwe dijk
� Doortrekken huidige buitentaludhelling tot nieuwe kruinhoogte
� De kruinbreedte blijft gelijk aan het huidige dijkprofiel
� Een eventuele binnentaludverflauwing wordt toegepast om de benodigde dijkba-

sistoename ten aanzien van macrostabiliteit te realiseren
� Een berm wordt aan het profiel geplakt om een eventueel pipingprobleem op te

lossen
2 Door het nieuwe dijkprofiel te matchen aan de beschikbare ruimte op een dijksectie,

uitgaande van de rekeninstellingen zoals gedefiniëerd in paragraaf 3.5.3, wordt gekeken
over welk deel van de dijksectie de versterking in grond kan worden toegepast.

3 Op plaatsen waar het nieuwe dijkprofiel in grond niet past in de beschikbare ruimte
wordt overgestapt op een reeks constructieve maatregelen, kwelscherm, stabiliteits-
wand of kistdam. Deze constructieve maatregelen hebben de eigenschap dat ze steeds
minder ruimte vragen om toe te kunnen passen, maar wel steeds duurder worden. Zie
ook figuur 4.3.

4 Voor alle bovenstaande maatregelen worden ten behoeve van de kostenraming hoe-
veelheden bepaald.

5 De kostenraming (investeringskosten) komt tot stand door de berekende hoeveelheden
te vermenigvuldigen met eenheidsprijzen en opslagfactoren volgens de SSK systema-
tiek.

6 Aan de raming per dijksectie worden componenten toegevoegd voor infrastructuur, dijk-
bekleding en kunstwerken, waarmee uiteindelijk de totale investeringskosten worden
bepaald.

De uiteindelijke resultaten van de raming wordt gepresenteerd voor het totale project en per
dijksectie. Zie hiervoor de volgende paragrafen. Wanneer na een berekening rekeninstel-
lingen voor een enkel dijkvak worden gewijzigd, zal het rekenresultaat voor het betreffende
dijkvak worden weggegooid. In een tweede berekeningsslag zal dan alleen voor dit dijkvak
een nieuwe raming gemaakt hoeven te worden. Wanneer globale rekeninstellingen gewijzigd
worden, of een nieuw importbestand geïmporteerd wordt, dient de berekening in z’n geheel
opnieuw gedraaid te worden.
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4.2 Resultaten totale project

Het venster waar de resultaten voor het gehele project (alle voor de berekening geselec-
teerde dijksecties) per scenario worden gepresenteerd is op te roepen via de menuoptie
Project>Project. Het scherm geeft de totale investeringskosten in tabel- en in grafiekvorm.
Verschillende scenario’s kunnen bijvoorbeeld worden gekenmerkt door verschillende maatge-
vende waterstanden voor de toekomstige situatie.

Bovenin het venster wordt weergegeven met welk prijspeil wordt gerekend, en of de bere-
kening in- of exclusief BTW is (dit kan worden ingesteld in het venster Eenheidsprijzen, pa-
ragraaf 3.4.3). Na een berekening verschijnen in de grijze velden per scenario de totale
investeringskosten voor ieder scenario. Wanneer na de berekening dijkvakken aan of uitge-
vinkt waarmee aangegeven wordt of ze al dan niet tot het project behoren (zie paragraaf 3.3),
worden de projectkosten direct geupdate. Wanneer in het totale project dijksecties zitten die
nog niet berekend zijn, worden in dit scherm geen rekenresultaten getoond. In dit geval dient
eerst weer een nieuwe berekening gedraaid te worden. Ook als er na het rekenen instellingen
gewijzigd worden, voor het gehele project, of voor een enkel dijkvak, zullen de resultaten hier
worden verwijderd.

Figuur 4.1: Totale investeringskosten voor alle geselecteerde dijksecties per scenario

4.3 Resultaten per dijksectie

Om de rekenresultaten op dijksectieniveau te bekijken moet de betreffende sectie eerst actief
gemaakt worden, hetzij door klikken in de tabel onderin het scherm, hetzij door klikken in de
kaart. Hierbij licht de geselecteerde dijksectie op, zie ook figuur 2.6. Bovenin het scherm
in de menubalk wordt in de rechter box de code van de actieve dijksectie weergegeven. In
dezelfde menubalk dient een keuze gemaakt te worden voor welk scenario de resultaten in
de user interface worden gepresenteerd.
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Er verschijnen nu op een aantal plaatsen in het scherm berekeningsresultaten:

� Kaart - kosten per km: In het ’Kaart’ scherm wordt in kleur voor alle dijksecties de
kosten per kilometer getoond voor het betreffende scenario. Zie de legenda voor een
overzicht van de gebruikte kleuren.

� Eigenschappen dijksectie - Maatregelen: In het ’Eigenschappen’ venster van de be-
treffende dijksectie verschijnt na de berekening een extra tabblad ’Maatregelen’. Hierin
zijn de berekeningsresultaten voor de dijksectie terug te vinden voor het geselecteerde
scenario (zie figuur 4.2). De investeringskosten zijn hier verdeeld in verschillende maat-
regelen met toenemende moeilijkheidsgraad, het aantal km waarop de maatregel wordt
toegepast (lengte (m)), totaalkosten voor die specifieke maatregel, aandeel bouwkos-
ten, aandeel vastgoedkosten (grondaankoop), en de eenheidsprijs (kosten/km). Boven
de tabel worden de totale investeringskosten en de investeringskosten/km voor de ge-
hele dijksectie weergegeven.

Figuur 4.2: Rekenresultaten per dijksectie

� Dwarsdoorsnede: in het ’Dwarsdoorsnede’ scherm verschijnen de representatieve
dwarsdoorsnedes voor- en na versterking, in respectievelijk donker- en lichtgroen voor
het betreffende scenario. Door in de menubalk bovenin het scherm een constructieve
maatregel te kiezen in de dropdown box, kan bekeken worden hoe de verschillende
constructieve maatregelen eruit zien in de dwarsdoorsnede. Zie ook figuur 4.3.

� Kaart - ruimtebeslag: Wanneer op de kaart wordt ingezoomd verschijnt in boven-
aanzicht het ruimtebeslag van de diverse maatregelen op een dijksectie. Hiermee is
precies te zien waar welke maatregel is berekend. Wanneer in de kaart viewer een van
de weblayers aangezet wordt (topografische kaarten of de luchtfoto), of externe sha-
pefiles met betrekking tot bebouwing in de invloedszone worden ingeladen, kan exact
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worden nagegaan om welke reden KOSWAT voor een bepaalde oplossing kiest op een
bepaalde plek. Zie hiervoor de figuur 4.3.

Figuur 4.3: Rekenresultaten dijksectie per scenario op de kaart

4.4 Exporteren rekenresultaten

4.4.1 Resultaten csv

Vanuit het menu Bestand>Export kunnen de berekeningsresultaten per scenario worden ge-
ëxporteerd als csv bestand. Na het kiezen van deze menuoptie dient een map aangegeven
te worden waar de csv bestanden kunnen worden weggeschreven. Per scenario wordt één
csv bestand weggeschreven met op iedere regel de resultaten voor een dijksectie. Voor de
exacte inhoud van de csv files, zie appendix C, paragraaf 3.1. In de loop van 2014 maakt
Deltares in opdracht van RWS een SSK uitvoersheet (MS Excel) beschikbaar waarmee de
csv bestanden in een SSK formaat ingelezen kunnen worden, zodat een nadere analyse op
de KOSWAT rekenresultaten mogelijk wordt.

4.4.2 Resultaten shape

Vanuit het menu Bestand>Export kunnen de berekeningsresultaten ook als shapefile worden
weggeschreven voor nadere analyse in een GIS pakket. Per dijksectie worden per scenario
de totale investeringskosten en de investeringskosten per km weggeschreven. Voor de exacte
inhoud van de shape file, zie appendix C, paragraaf 3.2.

4.4.3 Ruimtebeslag shape

Als laatste kunnen vanuit het menu Bestand>Export de shapes van het ruimtebeslag van de
versterkingsmaatregelen worden weggeschreven, zoals deze ook worden gevisualiseerd in
het ’Kaart’ venster. Voor de exacte inhoud en formats van de shape files, zie appendix C,
paragraaf 3.2.
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5 Info en support

Het huidige versienummer van KOSWAT is zichtbaar in het info scherm, te benaderen via het
menu Help (figuur 5.1). In dit scherm is tevens een overzicht te vinden van de release notes,
dus welke functionaliteit is aan deze laatste versie toegevoegd, en de bekende bugs.

Figuur 5.1: Versie informatie

Voor hulp bij het gebruik van de applicatie, kan gebruik gemaakt worden van voorliggende
handleiding, vanuit de applicatie te benaderen via het menu Help>Handleiding. Tevens kan
bij verschillende schermen direct naar de handleiding gesprongen worden door gebruik te
maken van de F1 toets.

Voor extra support na het lezen van de handleiding, het melden van bugs of het aanvragen
van nieuwe features voor een toekomstige versie kan een gebruiker contact opnemen met de
Helpdesk Water, bereikbaar via www.helpdeskwater.nl. Door het invoeren van de zoekterm
’koswat’ kom je terecht op onderstaande pagina, figuur 5.2. Aan de linkerzijde vanhet scherm
vind je het ’Meldingsformulier’.
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Figuur 5.2: www.helpdeskwater.nl
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6 KOSWAT console applicatie

Vanaf KOSWAT versie 2.3.2 is het mogelijk om KOSWAT te draaien zonder het opstarten
van de user interface. Hiermee wordt het mogelijk om vanuit een script of ander programma
KOSWAT aan te roepen, en direct zonder tussenkomst van de gebruiker een project door te
rekenen en de resultaten weg te schrijven.

In de map waarin KOSWAT geïnstalleerd is (per default c:\Program Files (x86)\Deltares\Koswat)
staat de executable ’Deltares.Koswat.console.exe’. Het programma wordt als volgt aangeroe-
pen met de volgende command line opties:

Deltares.Koswat.Console.exe <input.kwx> [<output.kwx>] [-export]

� input.kwx: Het argument is verplicht en specificeert het invoerbestand.
� output.kwx: Het argument is optioneel en kan zowel een volledig pad als een be-

standsnaam zijn. In het laatste geval is het pad hetzelfde als het invoerpad. Als out-
put.kwx wordt weggelaten, dan is het uitvoerbestand hetzelfde als het invoerbestand
(en wordt dus overschreven).

� -export: Het argument is optioneel en als deze wordt gespecificeerd, dan wordt de uit-
voer weggeschreven in csv bestanden, zoals beschreven in paragraaf 4.4.1. De naam
van de uitvoerbestanden wordt afgeleid van de uitvoerfile (die gelijk is aan de invoerfile
als dit argument was weggelaten). Het argument -export mag op een willekeurige plek
in de volgorde worden opgenomen.
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A Release notes

Bij de release van KOSWAT versie 2.3.2 heeft een eerste update van de gebruikershandlei-
ding plaatgevonden. Vanaf deze versie krijgt een gebruiker bij het opstarten van de software
de keuze op basis van welke template een nieuw project dient te worden gestart (zie pa-
ragraaf 3.1.1). Tevens kunnen nieuwe templates van internet worden gedownload wanneer
deze beschikbaar komen. Inmiddels zijn templates beschikbaar voor de verschillende prijs-
peilen 2013, 2014, 2015 en 2016.

Vanaf KOSWAT versie 2.3.2 is het mogelijk om KOSWAT te draaien zonder het opstarten
van de user interface. Hiermee wordt het mogelijk om vanuit een script of ander programma
KOSWAT aan te roepen, en direct zonder tussenkomst van de gebruiker een project door te
rekenen en de resultaten weg te schrijven. Zie voor een beschrijving hoofdstuk 6.

Voor de volledigheid staan hieronder de releasenotes van de eerdere versie 2.3 van KOSWAT
genoemd:

� KWX template update naar prijspeil 2013, incl. update dataset prijzen grondaankoop
� Online check op nieuwe KOSWAT versie bij startup (incl. release notes en known bugs)
� Alle invoerbestanden als CSV in plaats van XLS (InputPerDijkvak en Scenariofile)
� Referentiescenario (MHW en HBN) in Scenario-file ipv InputPerDijkvak.xls
� Automatische koppeling dijksecties en HR uitvoerpunten op basis van coordinaat, hand-

matig te overrulen vanuit applicatie
� Automatische koppeling kunstwerk aan dijksecties op basis van coordinaat
� Koppeling van kostencurves dijkbekleding (per km, WV21) aan dijksecties op basis van

shape
� Koppeling van prijzen grondaankoop aan dijkvak op basis van shape. Handmatig te

overrulen
� Feedback bij het succesvol inlezen van bestanden
� Betere foutafhandeling bij importeren bestanden. Check op aanwezigheid alle beno-

digde invoervelden. Wanneer essentiele gegevens ontbreken geen partiele update van
projectdata

� Check op consistentie dataset (bv kruinhoogte groter dan maaiveldhoogte, afstand naar
HR punt kleiner dan 1000 m, etc, etc)

� Bij openen KWX files checken op aanwezigheid en correcte koppeling OLP bestanden
� Verwijderen rekenresultaten bij veranderen rekeninstellingen
� Gebruikershandleiding beschikbaar als helpfile
� Help bij bepaalde instellingen/schermen/velden (F1 bij verschijnen tooltip popup)
� Naast sectiecode ook mogelijkheid voor opgeven sectienaam (in InputPerDijkvak en UI)
� Kleuren ruimtebeslag versterkingsmaatregelen in overeenstemming met doorsnede
� Aanvullen omgevingsanalyses ontbrekende dijkringen Limburg
� Mogelijkheid alle omgevingsdata uit te zetten (enkel versterkingen in grond)
� Diverse bugfixes
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B Installatie en systeemvereisten

KOSWAT draait op het Windows 7-platform, waarbij Microsoft .NET-versie 4.5 aanwezig moet
zijn. Om KOSWAT te kunnen installeren is ongeveer 500MB aan vrije schijfruimte nodig.

Een gebruiker kan tijdens de installatie opgeven waar de software geïnstalleerd dient te wor-
den, de omgevingsdatabases, ondergrondschematisaties en templates worden automatisch
geplaatst in de map c:\programdata\deltares\koswat.

Om KOSWAT op te starten dient te gebruiker op te starten via Start > Deltares > KOSWAT
of via het icoon op het bureaublad (figuur B.1).

Figuur B.1: Opstarten van KOSWAT.

Het huidige versienummer van KOSWAT is zichtbaar in het info scherm, te benaderen via het
menu Help (figuur 5.1). Wanneer een nieuwe versie van KOSWAT beschikbaar is, krijgt de
gebruiker hiervan bij het starten van KOSWAT een melding. De nieuwe versie kan vervolgens
via de Helpdesk Water (www.helpdeskwater.nl) gedownload worden (figuur B.2).

Figuur B.2: Aankondiging nieuwe versie
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C KOSWAT v2.3 invoer-, uitvoer- en projectbestanden

Op de volgende pagina’s volgt een omschrijving van de KOSWAT invoer-, uitvoer- en project-
bestanden.
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KOSWAT: invoer-, uitvoer- en projectbestanden (versie 2.3)

1. Inleiding

KOSWAT werkt met projectbestanden, zogenaamde KWX files (*.kwx), waarin projectdata die is
geïmporteerd of ingevoerd in de user interface (UI) wordt opgeslagen. KOSWAT KWX files zijn
feitelijk XML bestanden, die kunnen worden geopend en bewerkt in een tekst editor (bv.
Notepad++). Deze functionaliteit wordt op het moment niet ondersteund, aangezien een gebruiker
alle gegevens kan wijzigen vanuit de UI. Het exacte KWX format wordt daarom ook niet nader
omschreven.

De applicatie KOSWAT kan opgestart worden met twee niveaus van autorisatie, beheerder en
gebruiker. Dit document beperkt zich tot bestanden die door een gebruiker worden gebruikt.
Wanneer een gebruiker de applicatie start zal een template KWX file geopend worden, waarin de
beheerder al een aantal gegevens heeft klaargezet. Het gaat hier om de ligging van de dijkringlijnen
(dit is het totaal van alle dijkstrekkingen waar straks een berekening gemaakt kan worden), de
eenheidsprijzen, opslagfactoren en de default rekeninstellingen. Deze gegevens zijn in principe aan
te passen door de gebruiker, met uitzondering van de ligging van de dijkringlijnen.

Op basis van de ligging van de dijkringlijnen is door de beheerder een gegevensdatabase opgebouwd,
de dijkringlijnen en database zijn qua locaties 1-op-1 gekoppeld. De database wordt lokaal mee
geïnstalleerd met KOSWAT (en geplaatst in c:\programdata\deltares\koswat) en is niet aan te
passen door een gebruiker. De database bevat gegevens over bebouwing, spoorwegen, grote
waterpartijen en infrastructuur in een zone van 200m buitendijks tot 200m binnendijks. Dit is in
principe de zone waar de dijkversterking plaats vindt. De gegevens zijn per dijkring opgeslagen in
een *.olp bestand, in een (binair) database format genaamd ‘ProtoBuf’ van Google (vergelijkbaar
met SQLite).

2. Invoerbestanden

2.1. Dijkvakindeling

De gebruiker start zijn project in het algemeen met het inlezen van een dijkvakindeling (shapefile,
*.shp in combinatie met een *.shx, *.dbf en *.prj) . De stappen die worden gevolgd:

1. Exporteren van het dijkringlijnenbestand (shapefile) als template voor de vakindeling vanuit de
UI (hyperlink in het menu import).

2. Bewerken van de dijkringlijnen template in een GIS pakket tot een vakindeling die een gebruiker
wil beschouwen in een project. De dijkringsegmenten die geen onderdeel uitmaken van een
project worden uit de shape verwijderd, de resterende segmenten kunnen verder worden
opgeknipt tot dijkvakken met een uniforme uitgangssituatie (dijkprofiel, belastingsituatie,
ondergrond, ed). Ieder aaneengesloten dijkvak (geen multipart  polygons!) krijgt een uniek ID in
de database in het veld VAK.

3. Inlezen van de vakindeling shape in KOSWAT
4. Op de achtergrond wordt het dijkvak op basis van de ligging (begin- en eindpunt en vaklengte)

gekoppeld aan het betreffende stuk omgevingsdata.
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De *.dbf bij de shapefile  ziet er als volgt uit:

Veld Type Unit Beschrijving
DKRNR <Tekststring> - Het dijkringnummer waarin het betreffende dijkvak valt
VAK <Tekststring> - Een (willekeurig) uniek ID voor het betreffende dijkvak
LENGTH <Double> m De lengte van het betreffende dijkvak

2.2. Invoerdata per dijkvak

De gebruiker dient vervolgens voor ieder van zijn gedefinieerde dijkvakken (zie par 2.1) gegevens te
gaan toevoegen. Dit kan in de UI, maar de gegevens kunnen ook worden ingelezen vanuit een csv
file. Scheidingsteken is een puntkomma, voor het decimaalteken wordt verplicht de punt gebruikt.

Een template van het csv bestand met invoerdata per dijkvak kan geëxporteerd worden vanuit het
importscherm in KOSWAT.

Kolom Type Unit Beschrijving
Dijkvak <Tekststring> - Het unieke VAK ID  voor het betreffende

dijkvak, zoals gespecificeerd in de
dijkvakindeling.

Dijkvaknaam <Tekststring> - Willekeurige aanduiding waarmee het dijkvak
door de gebruiker kan worden
geidentificeerd

Dijkringnaam <Tekststring> - De naam van de dijkring waarin het dijkvak
valt

Beheerder <Tekststring> - De beheerder van het dijkvak
Dijkringdeel <Tekststring> - Het dijkringdeel waarin het dijkvak valt

(WV21, maar in principe vrij veld om later
dijkvakken bij elkaar op te kunnen tellen)

Dijktraject <Tekststring> - Het dijkringtraject waarin het dijkvak valt
(WV21, maar in principe vrij veld om later
dijkvakken bij elkaar op te kunnen tellen)

Categorie <Tekststring> - Categorie kering, voor KOSWAT categorie A
of C.

Grondprijs_Bebouwd
(EUR/m2)

<Double> €/m2 De directe kosten voor aankoop van grond in
bebouwd gebied. Invullen van dit veld is
optioneel, wanneer een gebruiker dit veld
leeg laat, wordt een (locatie specifieke)
default gebruikt zoals onderbouwd in het
eenheidsprijzenbestand ECK-B.

Grondprijs_Onbebouwd
(EUR/m2)

<Double> €/m2 De directe kosten voor aankoop van grond in
onbebouwd gebied. Invullen van dit veld is
optioneel, wanneer een gebruiker dit veld
leeg laat, wordt een (locatie specifieke)
default gebruikt zoals onderbouwd in het
eenheidsprijzenbestand ECK-B.

Buitendijks <Binary> - Mag je hier buitendijks versterken? (1=ja,
0=nee)

Profiel_RDX <Double> m X coördinaat van het maatgevende
profielpunt op de dijkringlijn in RD stelsel.
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Het profielpunt moet op de dijkringlijn van
het betreffende dijkvak liggen.

Profiel_RDY <Double> m Y coördinaat van het maatgevende
profielpunt op de dijkringlijn in RD stelsel.
Het profielpunt moet op de dijkringlijn van
het betreffende dijkvak liggen.

Buiten_Maaiveld (m+NAP) <Double> m+NAP De hoogteligging van het buiten maaiveld (zie
Figuur 1)

Buiten_Berm_Lengte (m) <Double> m De lengte van de buitenberm (zie Figuur 1)
Buiten_Berm_Hoogte
(m+NAP)

<Double> m+NAP De hoogteligging van de buitenberm (zie
Figuur 1)

Buiten_Talud (cotan) <Double> cotan De cotangens van de buitentalud helling (zie
Figuur 1)

Kruin_Breedte (m) <Double> m De breedte van de kruin (zie Figuur 1)
Kruin_Hoogte (m+NAP) <Double> m+NAP De hoogteligging van de kruin (zie Figuur 1)
Binnen_Talud (cotan) <Double> cotan De cotangens van de binnentalud helling (zie

Figuur 1)
Binnen_Berm_Hoogte
(m+NAP)

<Double> m+NAP De hoogteligging van de binnenberm (zie
Figuur 1)

Binnen_Berm_Lengte (m) <Double> m De lengte van de binnenberm (zie Figuur 1)
Binnen_Maaiveld (m+NAP) <Double> m+NAP De hoogteligging van het binnen maaiveld

(zie Figuur 1)
Uitvoerpunt <Tekststring> - De aanduiding van het (hydraulisch)

uitvoerpunt waaraan het vak gekoppeld
wordt (zie par 2.3). Invullen van dit veld is
optioneel, wanneer een gebruiker dit veld
leeg laat, wordt een koppeling gemaakt met
het geografisch dichtstbij gelegen
uitvoerpunt (binnen een straal van 1 km)

FactorSettlement <Double> - De dijkverhoging die nodig is om de dijk tot
ontwerphoogte te brengen, wordt
vermenigvuldigd met deze factor om tot de
aanleghoogte te komen. Dit is een correctie
voor zetting/klink van het dijklichaam.

Waakhoogte (m) <Double> m De minimale ontwerphoogte die de kruin
moet hebben boven de ontwerpwaterstand.

RobuustheidstoeslagWS (m) <Double> m Toeslag in het ontwerp op de
ontwerpwaterstand

RobuustheidstoeslagHBN (m) <Double> m Toeslag in het ontwerp op het Hydraulisch
Belasting Niveau.

FactorDijkbasis_stabiliteit <Double> De lengte waarmee de dijkbasis toeneemt
voor macrostabiliteit voor iedere meter
kruinstijging. Factor fs in figuur 2

Extra_Stabiliteitslengte (m) <Double> m De lengte waarmee de dijkbasis toeneemt
voor macrostabiliteit onafhankelijk van de
kruinstijging. Factor s in figuur 2

FactorDijkbasis_piping <Double> De lengte waarmee de dijkbasis toeneemt
voor piping voor iedere meter
waterstandsstijging. Factor fp in figuur 2

Extra_Pipingberm (m) <Double> m De lengte waarmee de dijkbasis toeneemt
voor piping onafhankelijk van de
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waterstandstijging. Factor p in figuur 2
Pleistoceen (m+NAP) <Double> m+NAP De ligging van de bovenzijde van de

draagkrachtige zandlaag
Pipinglaag (m+NAP) <Double> m+NAP De ligging van de bovenzijde van de

watervoerende laag (aquifer)

Figuur 1 Beschrijving dijkprofiel

Figuur 2 Factoren versterkingsmaatregel macro stabiliteit en piping.

2.3. Hydraulische scenario’s

De hydraulische scenario’s waarvoor per dijkvak uiteindelijk de kosten bepaald worden, worden
ontleend aan de scenariofiles (*.csv). Per csv bestand wordt één scenario gespecificeerd, bij het
importeren kan een map met meerdere scenariofiles worden geselecteerd. De naam van iedere
individuele file wordt in KOSWAT gebruikt als naam van het scenario. Naast de scenariofiles
waarvoor de berekening wordt uitgevoerd dient de map altijd een csv met een referentiescenario te
bevatten met de vaste naam Referentie.csv. Stijging van de hydraulische belasting wordt bepaald
ten opzichte van dit bestand.
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Per csv bestand worden de volgende kolommen ingelezen. De eerste 3 kolommen dienen identiek te
zijn voor het referentie scenario en alle ingelezen scenarios:

Kolom Type Unit Beschrijving
Uitvoerpunt <Tekststring> - De aanduiding van het uitvoerpunt.

Hiernaar kan verwezen worden
vanuit de invoerdata per dijkvak (par
2.2)

Uitvoerpunt_X (m) <Double> m X coördinaat van het maatgevende
uitvoerpunt op de dijkringlijn in RD
stelsel.

Uitvoerpunt_Y (m) <Double> m Y coördinaat van het uitvoerpunt op
de dijkringlijn in RD stelsel.

Waterstand (m+NAP) <Double> m+NAP De ontwerpwaterstand voor het
betreffende scenario.

HBN (m+NAP) <Double> m+NAP Het hydraulisch belasting niveau
voor het betreffende scenario.

Bodemdaling (m) <Double> m Bodemdaling voor het betreffende
scenario over de ontwerpperiode.

safety_factor_stability_inner_slope <Double> - Optioneel veld waarin de
veiligheidsfactor ten aanzien van
macrostabiliteit binnenwaarts kan
worden aangegeven wanneer op een
dijkvak een DAM berekening wordt
uitgevoerd

safety_factor_piping <Double> - Optioneel veld waarin de
veiligheidsfactor ten aanzien van
piping kan worden aangegeven
wanneer op een dijkvak een DAM
berekening wordt uitgevoerd

2.4. Dijkbekleding per dijkvak

In de huidige KOSWAT versie is de module voor de berekening van de kosten van dijkbekleding nog
niet overgenomen vanuit WV21. Desondanks bestaat de mogelijkheid om kosten voor dijkbekleding
toe te voegen aan het totale ramingsbedrag per scenario.

Hiertoe wordt een shapefile (*.shp in combinatie met een *.shx, *.dbf en *.prj) ingelezen, welke
voor iedere plek op de dijkringlijn een kostencurve per strekkende meter dijkvak voor dijkbekleding
bevat, als functie van de waterstandsstijging.  Ieder individueel dijkvak (par 2.1) wordt op basis van
de ligging van het midden van het dijkvak aan deze onderliggende shape gekoppeld.

De *.dbf file bij de shape bevat 23 kolommen, als volgt:

Kolom Type Unit Beschrijving
BEKLVAK <Tekststring> - Unieke aanduiding van het bekledingsvak
DKRNR <Tekststring> - Het dijkringnummer waarin het betreffende

bekledingsvak valt
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STAPGROOTT <Double> m De stapgrootte in meters waterstandsstijging
waarvoor kosten per m gegeven worden.

STAP_1 <Double> €/m Te hanteren eenheidskosten voor dijkbekleding
bij waterstandsstijging van 1 maal de
waterstandsstap.

STAP 2 <Double> €/m Te hanteren eenheidskosten voor dijkbekleding
bij waterstandsstijging van 2 maal de
waterstandsstap.

…
…
STAP_20 <Double> €/m Te hanteren eenheidskosten voor dijkbekleding

bij waterstandsstijging van 20 maal de
waterstandsstap.

2.5. Kunstwerken per dijkvak

In dit bestand worden de kunstwerken opgegeven die meegenomen worden in de kostenramingen
per dijkvak. Kunstwerken worden automatisch aan het dichtstbijzijnde dijkvak gekoppeld op basis
van hun geografische ligging, binnen een marge van 50 meter.

Het *.csv bestand bevat de volgende velden:

Kolom Type Unit Beschrijving
KunstwerkID <Tekststring> - Een unieke id voor het kunstwerk
Naam <Tekststring > - De naam van het kunstwerk
Beheerder <Tekststring > - De beheerder van het kunstwerk
RD_X <Double> m Het X coördinaat van het betreffende kunstwerk

in RD stelsel
RD_Y <Double> m Het Y coördinaat van het betreffende kunstwerk

in RD stelsel
Type <Tekststring> - Het type kunstwerk voor toepassing van de

standaard kostencurves. In dit veld dient een
combinatie gemaakt te worden van type en
grootteklasse, als volgt, bv. “Schutsluis – Groot”

Types:
- Coupure
- Gemaal
- Inlaatwerk
- Keersluis
- Schutsluis
- Uitwateringssluis
- Overige

Grootteklasses:
- Zeer klein
- Klein
- Middel
- Groot
- Special
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3. Uitvoerbestanden

3.1. Resultaten CSV

Vanuit de userinterface kunnen na het uitvoeren van een berekening bestanden (*.csv) met
rekenresultaten worden weggeschreven. Tevens wordt hierbij een KOSWAT projectfile (*.kwx)
weggeschreven, waarmee de rekenresultaten later eenvoudig kunnen worden gereproduceerd. Per
gedefinieerd scenario (paragraaf 2.3) wordt één csv bestand weggeschreven in een door de
gebruiker opgegeven map. Voor ieder dijkvak wordt in één regel de volgende resultaten
weggeschreven (170 kolommen):

De aanduiding MR1 t/m MR4 en CC1 t/m CC3 gaat over het type maatregel dat wordt toegepast op
een dijkvak:
MR1 = Oplossing in grond.
MR2 = Constructieve oplossing met licht kwelscherm in de teen van de dijk
MR3 = Constructieve oplossing met dam-/diepwand tot in de kruin van de dijk
MR4 = Kistdam
CC1 t/m 3 = Lokaties waar in de uitgangssituatie al een constructieve dijk is. Deze worden in de
kostenraming apart behandeld.

Kolom Type Unit Beschrijving
Dijkvak <Tekststring> - Het unieke VAK ID , zoals gespecificeerd in de

dijkvakindeling, invoer, zie par 2.1
Dijkring <Tekststring> - Het dijkringnummer waarin het betreffende

dijkvak valt, invoer, zie par 2.1
Dijkringnaam <Tekststring> - De naam van de dijkring waarin het dijkvak

valt, invoer, zie par 2.2
Dijkringdeel <Tekststring> - Het dijkringdeel waarin het dijkvak valt, invoer,

zie par 2.2
Dijkringtraject <Tekststring> - Het dijkringtraject waarin het dijkvak valt,

invoer, zie par 2.2
Lengte <Double> km De lengte van het betreffende dijkvak, invoer,

zie par 2.1
Beheerder <Tekststring> - De beheerder van het dijkvak, invoer, zie par

2.2
Categorie <Tekststring> - Categorie kering, voor KOSWAT categorie A of

C, invoer, zie par 2.2
Scenarionaam <Tekststring> - De naam van het betreffende hydraulisch

scenario, zie par 2.3
WS stijging <Double> m De waterstandsstijging in het beschouwde

scenario
HBN Stijging <Double> m De HBN stijging in het beschouwde scenario
Kruinstijging <Double> m De berekende kruinstijging in het beschouwde

scenario
Totaalkosten <Double> M€ De totaalkosten voor het dijkvak
Kosten per km <Double> M€/km De kosten voor het dijkvak per km
Grondprijsregio <Tekststring> - Leeg, kan vervallen
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Berekende hoeveelheden per versterkingsmaatregel MR1 t/m 4 (Maatregel in grond, Kwelscherm,
Stabiliteitswand, Kistdam). Voor MR2 t/m 4 komen grotendeels dezelfde velden voor als voor MR1,
deze zijn niet opnieuw beschreven
MR1 Lengte <Double> km Lengte van het dijkvak waarover MR1 van

kracht is.
MR1 Totaalkosten <Double> M€ Totaalkosten van dit onderdeel (MR1)
MR1 Kosten per km <Double> M€/km Kosten per km van dit onderdeel
MR1 Teelaarde <Double> m3 Hoeveelheid aanvoeren en verwerken

teelaarde (tbv grasbekleding) voor MR1
MR1 Klei <Double> m3 Hoeveelheid aanvoeren en verwerken klei

(afdeklaag) voor MR1
MR1 Zaadbank <Double> m3 Hoeveelheid als grasbekledingslaag in profiel te

verwerken voor MR1
MR1 Kern <Double> m3 Hoeveelheid als kernmateriaal in profiel te

verwerken voor MR1
MR1 Zand <Double> m3 Hoeveelheid aanvoeren en verwerken

kernmateriaal (zand) voor MR1
MR1 Afvoeren <Double> m3 Hoeveelheid af te voeren overtollig materiaal

voor MR1
MR1 Opp Profiel <Double> m2 Oppervlakte profiel voor profilering + inzaaien

voor MR1
MR1 Opp Afdeklaag <Double> m2 Oppervlakte afdeklaag voor profilering voor

MR1
MR1 Opp Kernlaag <Double> m2 Oppervlakte kernlaag (zandlichaam) voor

profilering voor MR1
MR1 Opp Maaiveld <Double> m2 Oppervlakte grondgebruik nieuw profiel voor

bewerking maaiveld voor MR1
MR1 Ruimte <Double> m Ruimtebeslag van MR1 tbv bepalen

grondaankoop
…
MR2 Lengte Damwand <Double> m Indien voor een damwand gekozen wordt als

kwelscherm de (verticale) lengte van de
constructie

MR2 Lengte
Cementbentonietwand

<Double> m Indien voor een cementbentonietwand
gekozen wordt als kwelscherm de (verticale)
lengte van de constructie

…
MR3 Lengte Damwand <Double> m Indien voor een damwand gekozen wordt als

stabiliteitswand de (verticale) lengte van de
constructie

MR3 Lengte Diepwand <Double> m Indien voor een diepwand gekozen wordt als
stabiliteitswand de (verticale) lengte van de
constructie

…
MR4 Lengte Kistdam <Double> m De (verticale) lengte van de kistdamconstructie
MR4 Breedte Kistdam <Double> m De breedte van de kistdamconstructie
…
CC1 Lengte <Double> km Lengte van het dijkvak waarop een

constructieve uitgangssituatie van kracht is van
het type 1 (zie handleiding)
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CC1 Totaalkosten <Double> M€ Kosten van het betreffende constructieve deel
CC2 Lengte <Double> km Lengte van het dijkvak waarop een

constructieve uitgangssituatie van kracht is van
het type 2 (zie handleiding)

CC2 Totaalkosten <Double> M€ Kosten van het betreffende constructieve deel
CC3 Lengte <Double> km Lengte van het dijkvak waarop een

constructieve uitgangssituatie van kracht is van
het type 3 (zie handleiding)

CC3 Totaalkosten <Double> M€ Kosten van het betreffende constructieve deel
Infrastructuur
Totaalkosten

<Double> M€ Totaalkosten van vervanging/aanpassing  van
infrastructuur op het dijkvak

Infrastructuur Infra
Type1

<Double> m2 Oppervlakte aan te passen infrastructuur
breedteklasse <2m (Top10NL)

Infrastructuur Infra
Type2

<Double> m2 Oppervlakte aan te passen infrastructuur
breedteklasse 2-4m (Top10NL)

Infrastructuur Infra
Type3

<Double> m2 Oppervlakte aan te passen infrastructuur
breedteklasse 4-7m (Top10NL)

Infrastructuur Infra
Type4

<Double> m2 Oppervlakte aan te passen infrastructuur
breedteklasse >7m (Top10NL)

Infrastructuur Infra
Type5

<Double> m2 Oppervlakte aan te passen infrastructuur
breedteklasse onbekend (Top10NL)

Kosten Kunstwerken
Totaalkosten

<Double> M€ Totaalkosten van vervanging/aanpassing  van
kunstwerken op het dijkvak

Kosten Bekleding
Totaalkosten

<Double> M€ Totaalkosten van vervanging/aanpassing  van
dijkbekleding op het dijkvak

Surfacelines van de dijk in de uitgangssituatie (Origineel) en de diverse versterkingsmaatregelen
MR1 t/m 4 (Maatregel in grond, Aanvullend gewicht (=kwelscherm), Enkelvoudige versteiling
(=stabiliteitswand), Tweezijdige versteiling (=kistdam))  Veldnamen worden aangepast in een
volgende versie!
Origineel_Buitenteen_X <Double> m X-coordinaat van profielpunt (1) van de

oorspronkelijke dijk in de
uitgangssituatie, zie figuur 1

Origineel_Buitenteen_Y <Double> m Y-coordinaat van profielpunt (1) van de
oorspronkelijke dijk in de
uitgangssituatie, zie figuur 1

Origineel_Kruin Buitenberm_X <Double> m X-coordinaat van profielpunt (2)
Origineel_Kruin Buitenberm_Y <Double> m Y-coordinaat van profielpunt (2)
Origineel_Insteek Buitenberm_X <Double> m X-coordinaat van profielpunt (3)
Origineel_Insteek Buitenberm_Y <Double> m Y-coordinaat van profielpunt (3)
Origineel_Buitenkruin_X <Double> m X-coordinaat van profielpunt (4)
Origineel_Buitenkruin_Y <Double> m Y-coordinaat van profielpunt (4)
Origineel_Binnenkruin_X <Double> m X-coordinaat van profielpunt (5)
Origineel_Binnenkruin_Y <Double> m Y-coordinaat van profielpunt (5)
Origineel_Insteek Binnenberm_X <Double> m X-coordinaat van profielpunt (6)
Origineel_Insteek Binnenberm_Y <Double> m Y-coordinaat van profielpunt (6)
Origineel_Kruin Binnenberm_X <Double> m X-coordinaat van profielpunt (7)
Origineel_Kruin Binnenberm_Y <Double> m Y-coordinaat van profielpunt (7)
Origineel_Binnenteen_X <Double> m X-coordinaat van profielpunt (8)
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Origineel_Binnenteen_Y <Double> m Y-coordinaat van profielpunt (8)
…
Maatregel in Grond_Buitenteen_X <Double> m Coördinaten van de profielpunten van

de maatregel in grond
…
Aanvullend Gewicht_Buitenteen_X <Double> m Coördinaten van de profielpunten van

de maatregel met een kwelscherm
...
Enkelvoudige Versteiling__Buitenteen_X <Double> m Coördinaten van de profielpunten van

de maatregel met een stabiliteitswand
…
Tweevoudige Versteiling_Buitenteen_X <Double> m Coördinaten van de profielpunten van

de maatregel met een kistdam
…

3.2. Resultaten shape

De resultaten shape is een shapefile (*.shp in combinatie met een *.shx, *.dbf en *.prj) in het RD
new stelsel waarin de berekeningsresultaten van de berekende dijkvakken per scenario
gepresenteerd worden.

De database bij de shape *.dbf bevat twee vaste en per scenario twee aanvullende datavelden:

Veld Type Unit Beschrijving
FID <Integer> - (Uniek) volgnummer
Name <Tekststring> - Het unieke VAK ID  voor het betreffende dijkvak, zoals

gespecificeerd in de dijkvakindeling.
S1_Cos <Double> €/m De gemiddelde kosten voor scenario 1 per strekkende meter
S1_Tot <Double> € De totale kosten voor scenario 1
S2_Cos <Double> €/m De gemiddelde kosten voor scenario 2 per strekkende meter
S2_Tot <Double> € De totale kosten voor scenario 2
…

3.3. Ruimtebeslag shapes

De ruimtebeslag shapes zijn een verzameling  shapefiles (*.shp in combinatie met een *.shx, *.dbf en
*.prj) in het RD new stelsel waarin het ruimtebeslag van de berekende scenario’s gepresenteerd
wordt.

De eerste shapefile bevat de ligging van de buitendijkteen van de originele dijk, en is genaamd
DikeToeOutside.shp. De shape bevat voor ieder dijkvak een polyline. De bijbehorende
DikeToeOutside.dbf file bevat de volgende velden:

Veld Type Unit Beschrijving
FID <Integer> - (Uniek) volgnummer
DikeRing <Tekststring> - Het betreffende dijkringnummer
DSection <Tekststring> - Het VAK ID  voor het betreffende dijkvak
OutlType <Tekststring> - Beschrijving van het type, in dit geval “DikeToeOutside”

KOSWAT v2.3 invoer-, uitvoer- en projectbestanden

Deltares 73 van 75



De tweede shapefile bevat de ligging van de binnendijkteen van de originele dijk, en is genaamd
DikeToeInside.shp. De shape bevat voor ieder dijkvak een polyline. De bijbehorende
DikeToeInside.dbf file bevat de volgende velden:

Veld Type Unit Beschrijving
FID <Integer> - (Uniek) volgnummer
DikeRing <Tekststring> - Het betreffende dijkringnummer
DSection <Tekststring> - Het VAK ID  voor het betreffende dijkvak
OutlType <Tekststring> - Beschrijving van het type, in dit geval “DikeToeInside”

De resterende shapefiles, één shape per scenario, geven de ligging van de binnendijkteen van de
versterkte dijk voor het betreffende hydraulisch scenario. Deze shapes hebben de naam van het
scenario. De shapes bevat voor ieder dijkvak meerdere polylines, al naar gelang verschillende
oplossingstypes afwisselend voorkomen. De bijbehorende *.dbf files bevat de volgende velden:

Veld Type Unit Beschrijving
FID <Integer> - (Uniek) volgnummer
DikeRing <Tekststring> - Het betreffende dijkringnummer
DSection <Tekststring> - Het VAK ID  voor het betreffende dijkvak
Scenario <Tekststring> - De scenarionaam
OutlType <Tekststring> - Beschrijving van het type maatregel, keuze uit:

“MeasureInGroundMeasure“ of
“AdditionalWeightMeasure“ of
“SingleSteepeningMeasure“ of
“DoubleSteepeningMeasure“ of
“CC1Measure“ of
“CC2Measure“ of
“CC3Measure“
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